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RECALIBRATION
Your Alicat instrument is a precision device and Alicat strongly 
recommends that you send it to us on a yearly basis for recalibration. 

A yearly recalibration does a few things: 

►► It insures that your unit is functioning according to specification. 

►► Contamination may cause the instrument to measure flow 
improperly. Recalibration insures the instrument is clean and free 
from debris.

►► Recalibration maintains your LIFETIME WARRANTY!

Sending your unit for recalibration is easy and inexpensive. Recalibrations 
are usually shipped within five days of receipt, so it’s fast too.

Please keep the original box to return your Alicat instrument for recalibration.

For more information regarding recalibration see page 44.

ACCESSORIES
Now that you have your Alicat instrument are you sure you’ve got 
everything you need? Alicat accessories can make your job easier.

Many of our customers also order:

►► Power Supplies — A universal wall power supply that makes it easy 
to power your Alicat unit just about anywhere in the world.

►► BB9 — Alicat’s multi-drop box that allows easy connection of up to 
nine Alicat instruments to a single USB, RS-232 or RS-485 port.

►► MD8DB9 — An RS-232 to 8 pin Mini-DIN cable to connect your 
Alicat instrument to a computer. A variety of other cables are also 
available.

►► Flow Vision™ SC — A GUI based Windows®program that allows easy 
computer access and control for one or multiple Alicat instruments.

►► Fittings and filters — Keep your instrument properly connected to 
your process and free from harmful contamination.

See  pages 50- 53 for a complete description and list of Alicat accessories.

FULL TECHNICAL SUPPORT | LIFETIME WARRANTY
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Notes for Using Alicat Water Flow Devices
►► USE ONLY PURE, CLEAN DI OR DISTILLED WATER IN THIS DEVICE. 
►► DO NOT use tap water or water with any biological components, 

minerals or oils. Any of these substances will affect the viscosity 
of the water (creating flow measurement inaccuracies). More 
importantly, these impurities will quickly build up in the laminar 
flow zone, cause corrosion, and render the measuring capabilities 
of the device useless. Pure DI water itself is corrosive to some 
extent, but it is the contaminants in your system that will be most 
detrimental to your Alicat liquid water flow meter.  
If you cannot meet the requirement of pure water, then do not 
use the Alicat water flow device in your application. Damage 
caused by impurity build up is not covered by the warranty.

►► Please read the operating manual that accompanied your device. 
Keep the manual for future reference.

►► When first using the Alicat water meter or controller for the day, 
please take the following precautions:
1.	 Apply your source pressure (approx. 20-30 psig for best 

results) to the device with the downstream flow blocked off. 
2.	 Then slightly open both bleed ports (DO NOT completely 

remove the screws) and allow any trapped air to escape. 
Allow some flow and let water pass through while bleeding 
(if the unit is a controller be sure to give it at least a 50% 
set-point). See page 11 of the manual for more information 
regarding bleed ports and bleeding.

3.	 Try not to get any water in-between the black electronics case 
and the stainless steel flow body. Wipe up any excess water 
around these seams. 

4.	 Tighten up both bleed screws, and then block the downstream 
water flow again. Visually verify zero flow through. 

Alicat Scientific, Inc.
7641 N Business Park Drive
Tucson, AZ 85743    USA

Please turn the page.
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5.	 Now you can safely tare (zero) a meter (page 19) using the 
tare button on the device, or in the case of a water flow 
controller, command the zero set‑point (page 29) which will 
auto-tare the unit.

►► Smooth and consistent source pressure is highly preferable, as any 
pulsing or fluctuation in water pressure will hydraulically couple to 
the differential pressure sensor, and the resultant flow reading will 
jump analogously.

►► Please note that, depending on model and flow range, water flow 
meters have an inherent internal pressure drop higher than that 
of standard gas flow meters of similar flow range. The minimum 
water device pressure drop is 2 psig, going all the way to 20 psig 
drop in certain models. Your source input pressure must meet or 
exceed this specification, in addition to any back pressure you 
may have on the downstream end of your process. Please see 
pages 51 - 54 of the manual or check our online specifications 
chart for model specific details. 

Please contact Alicat if you have any questions. We will be happy to help.

E-mail: info@alicat.com

Tel: 520-290-6060  or  888-290-6060

alicat.com

Notes for Using Alicat Water Flow Devices continued
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Thank you for purchasing an L-Series Water Flow Meter or LC or LCR Water 
Flow Controller. 

Please take the time to find and read the information contained in this 
manual. This will help to ensure that you get the best possible service 
from your instrument. This manual covers the following Alicat Scientific 
instruments:

	 L-Series Water Flow Meters

	 LC-Series Water Flow Controllers

	 LCR-Series Water Flow Controllers

This includes L, LC and LCR-Series devices labeled as approved for CSA 
Class 1 Div 2 and ATEX Class 1 Zone 2 hazardous environments. See 
pages 76 and 77 for Special Conditions regarding the use of CSA/ATEX 
labeled devices.

	 LB-Series Portable Water Meters
Note: All Alicat Portable Water Meters operate in accordance with the 
instructions found in this manual. Please see page 47 for information 
regarding portable use and recharge.

Please contact Alicat at 1-888-290-6060 or info@alicat.com if you 
have any questions regarding the use or operation of this device.
Many Alicat instruments are built for specific applications. Two 
instruments with the same flow range and part number may 
look and act quite differently depending upon the application the 
instrument was built for. Care should be taken when moving an 
instrument from one application to another.

You can find a number of instructional 
videos related to the operation of this 
device by visiting the Alicat web site or 
scanning the QR code.

http://www.alicat.com/support/instructional-videos/
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GETTING STARTED
8 Pin MiniDIN

Display Screen

Inlet Connection Port

Flow Direction Arrow

Outlet Connection Port

Power Jack

Bleed Screws

L Water Flow Meter shown with connection port fittings

Inlet Connection Port
Outlet Connection Port

Control Valve

LC Water Flow Controller shown with the standard downstream valve 
 and connection port fittings

Inlet Connection Port

Outlet Connection Port

Control Valve

LCR Water Flow Controller shown with the standard downstream valve 
 and connection port fittings
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MOUNTING
All L-Series Meters and LC-Series Controllers have mounting holes for 
convenient mounting to flat panels. The sizes and dimensions for the mounting 
holes are shown on pages 54-59.
Meters are position insensitive and can be mounted in any orientation. 
Small valve controllers (LC-Series) can usually be mounted in any position. 
Large valve controllers (LCR-Series) should be mounted so that the valve 
cylinder is vertical. Mounting a large valve controller in another position 
increases the risk of leakage when the controller is being held closed by the 
spring force.
Note: For applications that may continuously introduce occasional air bubbles 
to the flow stream upstream of the device, the device may be mounted 
upside down to prevent the bubbles from becoming trapped in the differential 
pressure sensor ports. 

If the device has been installed upside down, avoid using the bleed 
screws as water may leak into the electronics housing causing 
permanent damage that is not covered under warranty!

PLUMBING
Your controller is shipped with plastic plugs fitted in the port openings. 
To lessen the chance of contaminating the flow stream do not remove 
these plugs until you are ready to install the device.

Make sure that the water will flow in the direction indicated by the flow arrow.
Standard L-Series Meters and LC-Series Controllers have female inlet and outlet 
port connections. Welded VCR and other specialty fittings may have male ports.
The inlet and outlet port sizes (process connections) for different flow ranges 
are shown on pages 54-59.
Instruments with M5 (10-32) ports have O-ring face seals and require no 
sealant or tape. Do not use tape with welded or o-ring fittings.
For non M5 (10-32) ports use thread sealing Teflon® tape to prevent leakage 
around the port threads. 
Do not wrap the first two threads. This will minimize the possibility of getting 
tape into the flow stream and flow body. 

Do not use pipe dopes or sealants on the process connections as these 
compounds can cause permanent damage to the controller should they get 
into the flow stream.

When changing fittings, carefully clean any tape or debris from the port threads.
We recommend that a 20 micron filter be installed upstream of meter/
controllers with full scale ranges of 100 ccm or less and a 40 micron filter be 
installed upstream of meter/controllers with full scale ranges above 100 ccm.

Avoiding long runs of small diameter tubing upstream or downstream 
of the device will reduce water hammer.

Connecting Fittings and Filters 
http://www.alicat.com/support/instructional-videos/
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PRESSURE
Maximum operating line pressure is 100 psig (689 kPa). If the line pressure is 
higher than 100 psig (689 kPa), use a pressure regulator upstream from the 
flow controller to reduce the pressure to 100 psig (689 kPa)or less. 
Although the meter’s operation is uni-directional, reversing the flow direction 
will inflict no damage as long as the maximum specified limits are not 
exceeded. The differential pressure sensor utilized in this flow meter/controller 
is a very sensitive device capable of detecting minute differences in pressure.
Smooth and consistent source pressure is highly preferable, as any pulsing 
or fluctuation in water pressure will hydraulically couple to the differential 
pressure sensor, and the resultant flow reading will jump analogously.
Please note that, depending on model and flow range, water flow meters have 
an inherent internal pressure drop higher than that of standard gas flow meters 
of similar flow range. The minimum water device pressure drop is 2 psig, going 
all the way to 20 psig drop in certain models. Your source input pressure must 
meet or exceed this specification, in addition to any back pressure you may 
have on the downstream end of your process. 

CAUTION!  Exceeding the maximum specified line pressure may 
cause permanent damage to the solid-state differential pressure 
transducer.
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BLEED PORTS
Alicat Scientific L and LC-Series flow meters and controllers are equipped 
with bleed ports on the front to aid in the removal of air bubbles from the 
differential pressure sensor ports. The bleed ports consist of a threaded hole 
with an 8-32 nylon tipped screw. After installation or anytime it is suspected 
that air may be trapped in the sensor ports, bleed the ports as follows:

A small amount of water will leak from the device during this 
procedure. Take necessary precautions to prevent the leaking water 
from damaging anything around the unit, taking special care to avoid 
any live electrical devices or lines.

1.	 With the meter/controller installed and line pressure applied, gently loosen 
the upstream bleed port screw 1-2 turns or until water begins to leak from 
the threads. DO NOT REMOVE THE SCREW as the port is subject to line 
pressures and injury, equipment damage or loss of required parts may result!

2.	 Gently tap the flow body (a wooden or plastic screwdriver handle works 
well for this) to encourage air bubbles to exit the port.

3.	 Any air in the port will generally be removed as the water leaks out even 
though you may not see or hear it.

4.	 Gently tighten the screw until the leakage stops, taking care not to crush 
the nylon tip.

Repeat steps 1-4 with the second bleed port.

If your device is mounted in an inverted position avoid using the 
bleed screws as water may leak into the electronics housing causing 
permanent damage that is not covered under warranty!

8-32 Nylon Tipped Bleed Screw
5/64 Hex  Loosen to Bleed
DO NOT REMOVE!
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POWER AND SIGNAL CONNECTIONS
Power can be supplied to your meter/controller through either the power jack (power 
jack not available on CSA/ATEX approved devices) or the 8 pin Mini-DIN connector. 
An AC to DC adapter which converts line AC power to DC voltage and current as 
specified below is required to use the power jack. 
A 2.1mm, positive center, 7-30 Vdc AC/DC adapter rated for at least 100 mA is 
required to use the adapter jack in a L-Series meter.
A 2.1mm, positive center, 12-30 Vdc AC/DC adapter rated for at least 250 mA is 
required to use the adapter jack in a LC-Series controller. 
A 2.1mm, positive center, 24-30 Vdc AC/DC adapter rated for at least 750 mA is 
required to use the adapter jack in a LCR-Series controller.
NOTE: 4-20mA analog output requires at least 15 Vdc.

It is common to mistake Pin 2 (labeled 5.12 Vdc Output) as the standard 0-5 Vdc 
analog output signal. In fact Pin 2 is normally a constant 5.12 Vdc that reflects the 
system bus voltage and can be used as a source for the set-point signal.
For 6 Pin Locking Connector, DB9 and DB15 Pin‑outs see pages 63 to 75.
For PROFIBUS Pin‑outs see pages 62.

Electrical Connections and Basic Wiring
http://www.alicat.com/support/instructional-videos/

Standard 8 Pin Mini-DIN Pin-Out



 







1 2

3 4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Not Connected (or optional 4-20mA Primary Output Signal) Black

2 Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS-232RX / RS-485(–) Input Signal (receive) Red

4 Meters/Gauges = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS-232TX  / RS-485(+) Output Signal (send) Yellow
6 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue
8 Ground (common for power, communications and analog signals) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini‑DIN connector. The availability of different output signals depends on the options 
ordered. Optional configurations are noted on the unit’s calibration sheet.

CAUTION! Do not connect power to pins 1 through 6 as permanent 
damage can occur!
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INPUT SIGNALS
Analog Input Signal
Apply analog input to Pin 4 as shown on page 12.
For 6 Pin Locking Connector, DB9 and DB15 Pin‑outs see pages 63 to 75.
For PROFIBUS Pin‑outs see pages 62.
Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input 
signal to pin 4, with common ground on pin 8. 
Optional 0-10 Vdc: If specified at time of order, a 0-10 Vdc input signal can be 
applied to pin 4, with common ground on pin 8.
Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be 
applied to pin 4, with common ground on pin 8. 
NOTE: This is a current sinking device. The receiving circuit is essentially a 250 
ohm resistor to ground.  
NOTE: 4-20mA output requires at least 15 Vdc power input.

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.

Gauges: A remote tare can be achieved by momentarily grounding pin 4 to tare. 

 

7 6

5 4 3

2 1

8

5.12 Vdc

50 KOhm 
Potentiometer

0-5 Vdc

Controllers: A simple method for providing set-point to controllers

4

8
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RS-232 / RS‑485 Digital Input Signal

To use the RS-232 or RS-485 input signal, connect the RS-232 / RS‑485 Output 
Signal (Pin 5), the RS-232 / RS‑485 Input Signal (Pin 3), and Ground (Pin 8) to 
your computer serial port as shown below. (See page 32 for details on accessing 
RS-232 / RS‑485 input.)

DB9 to Mini-DIN Connection for RS-232 / RS-485 Signals

Electrical Connections and Basic Wiring
http://www.alicat.com/support/instructional-videos/













9 8 7 6



9876

15 3 24 1 532 4

Serial Cable End PC Serial Port


 









 











1

8 7 6

5

4

3

2

8 Pin MiniDIN Cable End 8 Pin MiniDIN Connector

9 Pin Serial Connection 8 Pin MiniDIN Connection
Pin Function Function Pin
5 Ground Ground 8
3 Transmit Receive 3
2 Receive Transmit 5
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OUTPUT SIGNALS

RS-232 / RS-485 Digital Output Signal

To use the RS-232 or RS-485 output signal, it is necessary to connect the RS-232 
/ RS‑485 Output Signal (Pin 5), the RS-232 / RS‑485 Input Signal (Pin 3), and 
Ground (Pin 8) to your computer serial port as shown on page 8. (See page 32 
for details on accessing RS-232 / RS‑485 output.)

Standard Voltage (0-5 Vdc) Output Signal

Meters/controllers equipped with a 0-5 Vdc (optional 0-10 Vdc) will have this 
output signal available on Pin 6. This output is generally available in addition to 
other optionally ordered outputs. This voltage is usually in the range of 0.010 
Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is linear 
over the entire range. Ground for this signal is common on Pin 8.

Optional 0-10 Vdc Output Signal

If your meter/controller was ordered with a 0-10 Vdc output signal, it will be 
available on Pin 6. (See the Calibration Data Sheet that shipped with your meter 
to determine which output signals were ordered.) This voltage is usually in the 
range of 0.010 Vdc for zero flow and 10.0 Vdc for full-scale flow. The output 
voltage is linear over the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal

If your meter/controller was ordered with a 4-20 mA current output signal, it 
will be available on Pin 1. (See the Calibration Data Sheet that shipped with 
your meter to determine which output signals were ordered.) The current 
signal is 4 mA at 0 flow and 20 mA at the meter’s full scale flow. The output 
current is linear over the entire range. Ground for this signal is common on Pin 
8. (Current output units require 15-30Vdc power.)

Optional 2nd Analog Output Signal

You may specify an optional 2nd analog output on Pin 2 at time of order. (See 
the Calibration Data Sheet that shipped with your meter to determine which 
output signals were ordered.) This output may be a 0-5 Vdc, 0-10 Vdc, or 
4-20 mA analog signal that can represent any measured parameter. With this 
optional output, a meter could output the volume flow rate (0-5 Vdc on pin 6) 
and the line temperature (0-5 Vdc on pin 2). 

If your device is equipped with the optional six pin industrial connector, 
please contact Alicat.

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.
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Typical Multiple Device (Addressable) Wiring Configuration

The easiest way to connect multiple devices is with a Multi-Drop Box 
(see page 50).

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.

5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2 1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow
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Information for Alicat TFT (Color Display) Instruments
Alicat TFT (color display) instruments have a high contrast back-lit LCD display. 
TFT instruments operate in accordance with Alicat standard operating instructions 
for our monochrome menus and displays with the following differences. 

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments 
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating 
under normal conditions.

RED: The color of a parameter is displayed in red when operating 
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the 
monochrome display.

LCD Contrast: 
LCD contrast is ranged from 0 to 11 on color displays with 11 being the greatest 
contrast.

Display On/Off: 
Pushing the button under the Alicat name will turn the device display on or off. 
This feature is not available on monochrome displays.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Alicat TFT (color display) meters, 
gauges and controllers only. All other operating specifications are shown in the 
Technical Data page for standard Alicat instruments. All standard device features 
and functions are available and operate in accordance with the Alicat operating 
manual provided with the device. 

Specification Meter  or 
Gauge

Small Valve 
Controller

Large Valve 
Controller

Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 
24Vdc
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PEAK
=0.0

MENU/
MAINU

CCM
+0.0

CCM

TOTAL/
TIMER

Totalizer (option only)

BACK RESET

000.00

#C
+21.50

+0.00
     CCM MENU 

TARE V PSIG
+13.60

CCM
WATER+0.00

The Main display shows, temperature 
and volume flow. Line pressure will be 
also be displayed if the meter was order 
with this option.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

If your meter was ordered with the 
Totalizer option (page 45), pushing the 
TOTAL button once will bring up the 
Totalizing Mode display. Pushing MENU 
a second time will bring up the Select 
Menu display.

DISPLAYS AND MENUS L METERS
(Displays and Menus for LC and LCR Controllers are shown beginning page 25.)

The device screen defaults to Main display as soon as power is applied to the meter.

Select Menu
From Select Menu you can interact 
with your RS-232 / RS-485 settings 
or read manufacturer’s data. 
Push MAIN to return to the Main display.

RS232 
COMM

MFG
DATA

MAIN

MISC

Select Menu

Main

2:05 h:m:s
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MAIN 
This mode defaults on power up, with flow 
as the primary displayed parameter. 
The following parameters are displayed in 
the Main mode.
Line Pressure: Only on units equipped with 
the optional pressure sensor, pressing 
the PSIG button will move the line gauge 
pressure to the primary display.

Line Temperature: Pressing the °C button 
will move the process temperature to the 
primary display.
Pushing the button again allows you to 
select 0C (Celsius), K (Kelvin), 0F (Fahrenheit) 
or 0R (Rankine) for the temperature scale. 
To select a temperature scale, use the UP 
and DOWN buttons to position the arrow in 
front of the desired scale. 
Press SET to record your selection and 
return to the MAIN display. The selected 
temperature scale will be displayed on 
the screen.

Tare: Pushing the TARE V button tares the 
flow meter and provides it with a reference 
point for zero flow. This is an important 
step in obtaining accurate measurements. 
It is best to zero the flow meter each time 

it is powered up. If the flow reading varies significantly from zero after an initial 
tare, give the unit a minute or so to warm up and re-zero it.

If possible, zero the unit near the expected operating pressure by positively blocking 
the flow downstream of the flow meter prior to pushing the TARE button. 

Zeroing the unit while there is any flow will directly affect the accuracy 
by providing a false zero point. If in doubt about whether a zero flow 

condition exists, remove the unit from the line and positively block both ports 
before pressing the TARE button. If the unit reads a significant negative value 
when removed from the line and blocked, it was given a false zero. It is better 
to zero the unit at atmospheric pressure and a confirmed no flow condition 
than to give it a false zero under line pressure.

It is not uncommon for a meter to read a small value when it is removed from 
the process line as water can “hang” in one or both of the differential pressure 
sensor ports. If the unit reads a significant negative value when removed from 
the line and blocked, it is a good indication that it was given a false zero.

#C
+21.50

+0.000
CCM MENU

TARE V

CCM
WATER

PSIG
+13.60

DOWN

CANCEL SET

MODE

  >#C
    K
    #F
    #R
   

UP

+0.00
Volu Flow
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SELECT MENU
From Select Menu you can interact with your RS‑232 / RS-485 settings or read 
manufacturer’s data.
Press the button next to the desired operation to bring that function to the screen.

An explanation for each screen can be found on the following pages.

RS232 
COMM

MFG
DATA

MAIN

MISC

Miscellaneous
Communication Select

Main

Manufacturer Data

#C
+21.50

+0.000
CCM MAIN

TARE V

CCM

PSIA
+13.60

+   .

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109

BACK MAIN

UNIT ID
A

BAUD
19200

Select Menu

Volume: The volume flow rate is defaulted on the primary display. Press the 
unit of measure button (ccm in the example) to return the volume flow rate to 
the primary display.
MENU: Pressing MENU switches the screen to the Select Menu display.

Flashing Error Message: An error message ( VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) 
flashes when a measured parameter exceeds the range of the sensor. 
When any item flashes, neither the flashing parameter nor the flow 

measurement is accurate. Reducing the value of the flashing parameter to within 
specified limits will return the unit to normal operation and accuracy. 

If the unit does not return to normal operation contact Alicat.

MISC2

BACK
DEVICE/

UNITS MAIN

MISC1
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COMMUNICATION SELECT
Access Communication Select by pressing 
the button above RS232 COMM or RS485 
COMM on the Select Menu display. 
Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS‑232 or RS‑485 
computer port. 
Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID.
Any Unit ID change will take effect when 
Communication Select is exited.
If the symbol @ is selected as the Unit 
ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS-232 Communications (page 32) for 
information about the streaming mode.
Baud – Both this instrument and your 
computer must send/receive data at the 
same baud rate. The default baud rate for 
this device is 19200 baud. 
Press the Select button until the arrow is 
in front of Baud. Use the UP and DOWN 
buttons  to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. 
Any baud rate change will not take effect 
until power to the unit is cycled.

UP

BACK RESET A SET

UNIT ID
C

DOWN

DOWN

BACK SET

BAUD UP

19200

BACK MAIN

UNIT ID
A

BAUD
19200

C
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MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
Next select either MISC1 or MISC2. 

MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband. 
Zero deadband is a value below which the display 
jumps to zero. This deadband is often desired to 
prevent electrical noise from showing up on the 
display as minor flows or pressures that do not 
exist. Display Zero Deadband does not affect the 
analog or digital signal outputs.
ZERO BAND can be adjusted between 0 and 
6.3% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to choose 
the digit with the arrow and the UP and DOWN 
buttons to change the value. Press SET to record 
your value. Press CLEAR to return to zero.
Pressure Averaging and Flow Averaging may 
be useful to make it easier to read and interpret 
rapidly fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 1 
(no averaging) and 256 (maximum averaging). 
These are geometric running averages where 
the number between 1 and 256 can be 
considered roughly equivalent to the response 
time constant in milliseconds. 

This can be effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and 
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to 
return to zero.

Press FLOW AVG. Then use SELECT to choose the 
digit with the arrow and the UP and DOWN buttons 
to change the value. Press SET to record your value. 
Press CLEAR to return to zero.
Setting a higher number will equal a smoother 
display. 
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 31, with zero being the 
lightest and 31 being the darkest. Use the UP 
and DOWN buttons to adjust the contrast. Press 
SET when you are satisfied. Press CANCEL to 
return to the MISC display.

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

DOWN

CANCEL CLEAR SET

UP SELECT

0.0

>

DOWN

CANCEL RESET SET

UP

11



23

MISC2 will display as shown at left. 
Press ROTATE DISP and SET to Inverted 180° 
if your device is inverted. The display and 
buttons will rotate together.
If the device has been installed upside 
down, avoid using the bleed screws as 
water may leak into the electronics housing 
causing permanent damage that is not 
covered under warranty!

DIAG TEST: This diagnostic screen displays 
the current internal register values, which 
is useful for noting factory settings prior 
to making any changes. It is also helpful 
for troubleshooting with Alicat customer 
service personnel.
Select the DIAG TEST button from the MISC2 
screen to view a list of select register values. 
Pressing the SCROLL button will cycle the 
display through the register screens. An 
example screen is shown at left.

DIAG
TEST

BACK MAIN

ROTATE 
DISP

BACK MAIN

SCROLL
R8:     AP Sig	 7871
R9:     Temp Sig	 39071
R10:    DP Side	 9986
R11:     DP Brdg	 36673
R13:    AP Brdg	 36673
R16:    Meter Fun	 199
R18:    Power Up	 32768
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MANUFACTURER DATA
Manufacturer Data is accessed by pressing the MFG DATA button on the Select 
Menu display. The initial display shows the name and telephone number of 
the manufacturer. Press MODEL INFO to show important information about 
your flow device including the model number, serial number, and date of 
manufacture. 
Press BACK to return to the MFG DATA display.
Push MAIN to return to the Main display.

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109

BACK MAIN

MODEL:  � LC-10SLPM-D
SERIAL  NO:  � 120003
DATE  MFG:    � 10/7/2014
DATE  CAL:    � 10/9/2014
CAL  BY:  � DL
SW REV:  � 5v00

DEVICE UNITS
Press DEVICE UNITS to access menus of units 
of measure for each parameter (and totalizer 
if so equipped).
Scroll to the desired unit and press select.
Once selected, you will see the message 
shown below. Verify that all connected 
devices expect the change.
See pages 40 and 41 for a full list of available 
units.

DOWN

DONE SELECT

Volumetric Flow
Pressure
Temperature

UP

DOWN

CANCEL SET

PAGE
CCM
cm3/h
m3/h
m3/d
in3/m
CFH
%

UP
PRESSING SET WILL

AFFECT DISPLAY
AND SERIAL VALUES

VERIFY CONNECTED 
SERIAL DEVICES 

EXPECT THE CHANGE

SETCANCEL
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SETPT

MENU/
MAINU

CCM
+0.0

CCM

TOTAL/
TIMER

Totalizer (option only)

BACK RESET

000.00
2:05 h:m:s

#C
+21.50

+0.00
     CCM MENU 

SETPT
0.00 

PSIG
+13.60

CCM
WATER+0.00

The Main display shows, temperature 
and volume flow. Line pressure will be 
also be displayed if the meter was order 
with this option.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

If your controller was ordered with the 
Totalizer option (page 45), pushing the 
TOTAL button once will bring up the 
Totalizing Mode display. Pushing MENU 
will bring up the Select Menu display.

DISPLAYS AND MENUS LC AND LCR CONTROLLERS
(Displays and Menus for L Meters are shown beginning page 18.)

The device screen defaults to Main display as soon as power is applied to the controller.

Select Menu
From Select Menu you can interact 
with your RS-232 / RS-485 settings, 
read manufacturer’s data or access 
the control set-up display. 
Push MAIN to return to the Main display.

CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

Select Menu
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MAIN 
This mode defaults on power up, with flow 
as the primary displayed parameter. 
The following parameters are displayed in 
the Main mode.
Line Pressure: Only on units equipped with 
the optional pressure sensor, pressing 
the PSIG button will move the line gauge 
pressure to the primary display.

Line Temperature: Pressing the °C button 
will move the process temperature to the 
primary display.
Set Point: The set-point (SETPT)is shown 
in the upper right of the display. 

For information on changing the set-point see SETPT SOURCE, page 28.

Volume: The volume flow rate is defaulted on the primary display. Press the 
unit of measure button (ccm in the example above) to return the volume flow 
rate to the primary display.
MENU: Pressing MENU switches the screen to the Select Menu display.

#C
+21.50

+0.00
CCM MENU

SETPT
0.00  

PSIG
+13.60

Flashing Error Message: An error message ( VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) 
flashes when a measured parameter exceeds the range of the sensor. 
When any item flashes, neither the flashing parameter nor the flow 

measurement is accurate. Reducing the value of the flashing parameter to within 
specified limits will return the unit to normal operation and accuracy. 

If the unit does not return to normal operation contact Alicat.

CCM
WATER+0.00

VoluFlow
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#C
+21.50

+0.00
     CCM MENU 

SETPT
0.00 

PSIG
+13.60

CCM
WATER+0.00CONTROL

SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

SELECT MENU
From Select Menu you can change the selected gas, interact with your 
RS‑232 / RS-485 settings, read manufacturer’s data and access the control 
setup screen.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communication Select

Control Setup

Main

Manufacturer Data

An explanation for each screen can be found on the following pages:
Control Setup: Please see page 28.

Communication Select: Please see page 21.

Miscellaneous: Please see page 22.

Manufacturer Data: Please see page 24.

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109

LOOP
VAR

-OFF-
AUTO
TARE PID MAIN

SETPT
SOURCE

MISC2

BACK
DEVICE
UNITS MAIN

MISC1

BACK MAIN

UNIT ID
A

BAUD
19200

SETPT
+0.00  

Select Menu
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CONTROL SETUP 
Control Setup is accessed by pressing the button below Control Setup on the 
Select Menu display. From this screen you can select your set-point source, 
choose a loop variable and adjust the PID terms.

Press BACK to return to the Select Menu 
display. 
Press MAIN to return to the MAIN display
SETPT SOURCE – Pressing the button 
above SETPT SOURCE will allow you to 
select how the set point will be conveyed 
to your controller. 
Use the line-up and line-down buttons 
to move the arrow in front of the desired 
option. Then press SET.
Press CANCEL to return to the previous 
display. 
The controller will ignore any set-point 

except that of the selected set-point source and it will remember which input is 
selected even if the power is disconnected.

Serial refers to a remote digital RS-232 
/ RS-485 set-point applied via a serial 
connection to a computer or PLC as 
described in the installation and RS‑232 / 
RS-485 sections of this manual. 

Front Panel refers to a set-point applied 
directly at the controller. 

Front Panel input must be selected 
prior to changing the set-point at 
the device. 

Analog refers to a remote analog set-
point applied to Pin 4 of the Mini-DIN 
connector as described in the installation 

section of this manual. The standard analog input is 0-5 Vdc. 
To determine what type of analog set-point your controller has, refer to 
the Calibration Data Sheet that was included with your controller. 

If nothing is connected to Pin 4, and the controller is set for analog control, the 
device will generate random set-point values. 
NOTE: If your controller has the IPC (Integrated Potentiometer Control) option, 
the IPC dial will operate with the ANALOG set-point source selected.

SETPT refers to the set-point. This parameter may be changed using the display 
only if FRONT PANEL is selected as the Input. Press SETPT. Then use SELECT to 
choose the decimal with the arrow and the UP and DOWN buttons to change 
the value. Press SET to record your value. Press CLEAR to return to zero.

DOWN

CANCEL SET

UP

 >Serial/Front Panel
   Analog

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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CAUTION!  Never leave a Controller with a non-zero set‑point if 
no pressure is available to make flow. The controller will apply 
full power to the valve in an attempt to reach the set‑point. 
When there is no flow, this can make the valve very HOT!

CONTROL SETUP (continued)
LOOP VAR—Water flow controllers are 
defaulted to volume flow. 
Volume means that the controller is 
“closing the loop” on the volume flow 
rate. This means that when you give 
the controller a set-point, the controller 
compares that set-point to the measured 
volume flow rate and adjusts the valve 
to try to make the flow and the set-point 
match. For the volume flow rate, the input 
signal (e.g. 0-5 Vdc) corresponds to the 
full-scale flow rate for the device.

ON AUTO / OFF AUTO—refers to the 
standard auto-tare or “auto-zero” feature.

The auto-tare feature automatically tares 
(takes the detected signal as zero) the unit 
when it receives a zero set-point for more 
than two seconds. 
A zero set-point results in the closing 
of the valve and a known “no flow” 
condition. This feature makes the device 
more accurate by periodically removing any 
cumulative errors associated with drift. 

It is recommended that the controller be left in the default auto-tare 
ON mode unless your specific application requires that it be turned off. 

LOOP
VAR

-OFF-
AUTO
TARE PID MAIN

SETPT
SOURCE

DOWN

CANCEL SET

UP MODE

 >   Volumetric Flow
   

SETPT
+0.0
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PID TUNING

PID Values determine the performance 
and operation of your proportional 
control valve. These terms dictate control 
speed, control stability, overshoot and 
oscillation. All units leave the factory with 
a generic tuning designed to handle most 
applications. If you encounter issues with 
valve stability, oscillation or speed, fine 
tuning these parameters may resolve the 
problem.
Alicat controllers allow you to adjust the 
Proportional, Integral and Differential 
terms of the PID control loop. 
To change the PID loop parameters, push 
the button below PID.
Press LOOP TYPE. Then use the UP and 
DOWN buttons to select the appropriate 
PID control algorithm. Press SET.
See the following page for descriptions 
of the PID Loop Types (PID Control 
Algorithms).

P refers to the Proportional term of the 
PID loop. 
I refers to the Integral term of the PID loop. 
D refers to the Differential term of the PID 
loop. 
Press P, I or D. Then use SELECT to choose 
the decimal with the arrow and the UP 
and DOWN buttons to change the value. 
Press SET to record your value. Press 
CLEAR to return to zero.

Before changing the P, I or D 
parameter, please record the initial 
value so that it can be returned to 

the factory setting if necessary.
Valve tuning can be complex. If you 
would like assistance, please contact 
Alicat for technical support.

I
00000

BACK
LOOP
TYPE MAIN

P
00100

D
02501

DOWN

CANCEL SET

UP MODE

 >PD PID
   PD2I PID

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0

Overview of PID Adjustment on Alicat Flow and Pressure Controllers
http://www.alicat.com/support/instructional-videos/
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The PD algorithm is the PID algorithm used on most Alicat controllers.
It is divided into two segments:
The first compares the process value to the set-point to generate a proportional 
error. The proportional error is multiplied by the ‘P’ gain, with the result added 
to the output drive register. 
The second operates on the present process value minus the process value during 
the immediately previous evaluation cycle. This ‘velocity’ term in multiplied by 
the ‘D’ gain, with the result subtracted from the output drive register. 
The above additions to and subtractions from the output drive register 
are carried over from process cycle to process cycle, thus performing the 
integration function automatically. 
Increasing the ‘P’ gain will promote the tendency of the system to overshoot, 
ring, or oscillate. 
Increasing the ‘D’ gain will reduce the tendency of the system to overshoot. 
The PD2I algorithm is a PID algorithm used primarily for high performance 
pressure and flow control applications. 
It exhibits two basic differences from the PD algorithm that most controllers utilize.

1. Instead of applying a damping function based upon the rate of change of the 
process value, it applies a damping function based upon the square of the rate of 
change of the process value.
2. The damping function is applied directly to the proportional error term 
before that term is used in the proportional and integral functions of the 
algorithm. This provides a certain amount of ‘look ahead’ capability in the 
control loop.

Because of these differences, you will note the following:
1. Increasing ‘P’ gain can be used to damp out overshoot and slow oscillations 
in pressure controllers. You will know that ‘P’ gain is too high, when the 
controller breaks into fast oscillations on step changes in set-point. On flow 
controllers, too high a ‘P’ gain results in slower response times. Too low a ‘P’ 
gain results in overshoot and/or slow oscillation. A good starting value for ‘P’ 
gain is 200.
2. If the unit was originally shipped with the PD2I algorithm selected, the 
‘D’ gain value should be left at or near the factory setting because it relates 
primarily to the system phase lags. If you are changing from the default 
algorithm to the PD2I algorithm, you should start with a ‘D’ gain value of 20.
3. The ‘I’ gain is used to control the rate at which the process converges 
to the set-point, after the initial step change. Too low a value for ‘I’ gain 
shows up as a process value that jumps to near the set-point and then takes 
awhile to converge the rest of the way. Too high a value for ‘I’ gain results in 
oscillation. A good starting value for the ‘I’ gain is 200.
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RS-232 / RS-485 Output and Input
Configuring HyperTerminal®:

1.	 Open your HyperTerminal® RS-232 / RS-485 terminal program (installed under 
the “Accessories” menu on all Microsoft Windows® operating systems).

2.	 Select “Properties” from the file menu.
3.	 Click on the “Configure” button under the “Connect To” tab. Be sure the 

program is set for: 19,200 baud (or matches the baud rate selected in the 
RS-232 / RS-485 communications menu on the meter) and an 8-N-1-None 
(8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.

4.	 Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI 
or Auto Detect.

5.	 Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line 
Feeds” box is not checked and the “Echo Typed Characters Locally” box 
and the “Append Line Feeds to Incoming Lines” boxes are checked. Those 
settings not mentioned here are normally okay in the default position.

6.	 Save the settings, close HyperTerminal® and reopen it.

Streaming Mode (RS-485 units do not have a streaming mode)

In the default Polling Mode, the screen should be blank except the blinking cursor. 
In order to get the data streaming to the screen, hit the “Enter” key several times 
to clear any extraneous information. Type “*@=@” followed by “Enter” (or using 
the RS‑232 / RS-485 communication select menu, select @ as identifier and exit 
the screen). If data still does not appear, check all the connections and COM port 
assignments.

Streaming Mode – Advanced 

The streaming data rate is controlled by register 91. The recommended default rate 
of data provision is once every 50 milliseconds and this is suitable for most purposes. 

If a slower or faster streaming data rate is desired, register 91 can be changed to a 
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute. 

Below approximately 40 milliseconds, data provision will be dependent upon 
how many parameters are selected. Fewer data parameters can be streamed 
more quickly than more. It is left to the user to balance streaming speed with 
number of parameters streamed. 

To read register 91, type “*r91” followed by “Enter”. 

To modify register 91, type “*w91=X”, where X is a positive integer from 1 to 
65535, followed by “Enter”. 

To return to the recommended factory default streaming speed, type “*w91= 50”.
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Tareing via RS-232 / RS-485 (L-Series only): 
Tareing (or zeroing) the flow meter provides it with a reference point for 
zero flow. This is a very simple but important step in obtaining accurate 
measurements. It is good practice to “zero” the flow meter each time it is 
powered up. 

If the flow reading varies significantly from zero after an initial tare, give the 
unit a minute or so to warm up and re-zero it. If possible, it is helpful to zero 
the unit near the expected operating pressure by positively blocking the flow 
downstream of the flow meter prior to entering the Tare command. Zeroing the 
unit while there is any flow will directly affect the accuracy by providing a false 
zero point. 

If in doubt about whether the flow is positively blocked, remove it from the line 
and positively block both ports before entering the Tare command. If the unit 
reads a significant negative value when removed from the line and blocked, it 
is a good indication that it was given a false zero. It is better to zero the unit at 
atmospheric pressure and a confirmed no flow conditions than to give it a false 
zero under line pressure. To send a Tare command via RS-232 / RS-485, enter 
the following strings:

In Polling Mode:		  Address$$V<Enter>        (e.g. B$$V<Enter>)
Sending a Set-point via RS-232 / RS-485: To send a set-point via RS-232 / RS-485, 
“Serial” must be selected under the “Input” list in the control set up mode. 
Method 1:  Set-point may be set in floating point in serial communication using 
serial command (UnitID)SX.YZ 

Example:  AS4.54 results in Unit ID A changing set-point to 4.54.  
Method 2: Type in a number between 0 and 65535 (2% over range), where 64000 
denotes full-scale flow rate, and hit “Enter”. 

The set-point column and pressure rates should change accordingly. If they do 
not, try hitting “Enter” a couple of times and repeating your command. The 
formula for performing a linear interpolation is as follows:

	 Value = (Desired Set-point X 64000) / Full Scale Flow Range

For example, if your device is a 500 ccm full-scale unit and you wish to apply a 
set-point of 125 ccm you would enter the following value:

 	 16000 = (125 ccm X 64000) / Full Scale Flow Range

If the controller is in polling mode as described in Changing from Streaming 
Mode to Polling Mode, the set-point must be preceded by the address of the 
controller. For example, if your controller has been given an address of D, the 
set-point above would be sent by typing:

 	 D16000 followed by “Enter”
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To adjust the Proportional and Differential (P&D) terms via RS-232 / RS-485 
(LC and LCR-Series only):

Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21   
followed by “Enter”.

The computer will respond by reading the current value for register 21 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 21. For example, if you wished to try a “P” term of 220, you 
would type *W21=220 followed by “Enter” where the bold number denotes the 
new value.

The computer will respond to the new value by confirming that 21=220. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once. You 
may type A “Enter” as many times as you like. Alternately, you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove 
the unit from the streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed 
by “Enter”.

The computer will respond by reading the current value for register 22 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 22. For example, if you wished to try a “D” term of 25, you 
would type *W22=25 followed by “Enter” where the bold number denotes the 
new value. 

The computer will respond to the new value by confirming that 22=25. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once. You 
may type A “Enter” as many times as you like. Alternately you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat. 

You may test your settings for a step change by changing the set-point. To do 
this type A32000 (A is the default single unit address, if you have multiple 
addressed units on your RS-232 / RS-485 line the letter preceding the value 
would change accordingly.) followed by “Enter” to give the unit a ½ full scale 
set-point. Monitor the unit’s response to the step change to ensure it is 
satisfactory for your needs. Recall that the “P” term controls how quickly the 
unit goes from one set-point to the next, and the “D” term controls how quickly 
the signal begins to “decelerate” as it approaches the new set-point (controls 
the overshoot).
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Changing From Streaming to Polling Mode: 

When the meter is in the Streaming Mode (RS-485 units do not have a 
streaming mode), the screen is updated approximately 10-60 times per second 
(depending on the amount of data on each line) so that the user sees the data 
essentially in real time. It is sometimes desirable, and necessary when using 
more than one unit on a single RS-232 line, to be able to poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of 
data when it is “polled”. Each unit can be given its own unique identifier or 
address. Unless otherwise specified each unit is shipped with a default address 
of capital A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of 
information filling your screen:

1.	 Type *@=A followed by “Enter” (or using the RS-232 / RS-485 
communication select menu, select A as identifier and exit the screen) to 
stop the streaming mode of information. Note that the flow of information 
will not stop while you are typing and you will not be able to read what you 
have typed. Also, the unit does not accept a backspace or delete in the line 
so it must be typed correctly. If in doubt, simply hit enter and start again. If 
the unit does not get exactly what it is expecting, it will ignore it. If the line 
has been typed correctly, the data will stop.

2.	 You may now poll the unit by typing A followed by “Enter”. This does an 
instantaneous poll of unit A and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming 
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

3.	 To assign the unit a new address, type *@=New Address, e.g. *@=B. Care 
should be taken not to assign an address to a unit if more than one unit 
is on the RS-232 / RS-485 line as all of the addresses will be reassigned. 
Instead, each should be individually attached to the RS-232 / RS-485 line, 
given an address, and taken off. After each unit has been given a unique 
address, they can all be put back on the same line and polled individually.
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Collecting Data:

The RS-232 / RS-485 output updates to the screen many times per second. 
Very short-term events can be captured simply by disconnecting (there are 
two telephone symbol icons at the top of the HyperTerminal® screen for 
disconnecting and connecting) immediately after the event in question. The 
scroll bar can be driven up to the event and all of the data associated with 
the event can be selected, copied, and pasted into Microsoft® Excel® or other 
spreadsheet program as described below.

For longer term data, it is useful to capture the data in a text file. With the 
desired data streaming to the screen, select “Capture Text” from the Transfer 
Menu. Type in the path and file name you wish to use. Push the start button. 
When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from 
a text file can be pasted directly into Excel®. When the data is pasted it will all 
be in the selected column. Select “Text to Columns...” under the Data menu in 
Excel® and a Text to Columns Wizard (dialog box) will appear. Make sure that 
“Fixed Width” is selected under Original Data Type in the first dialog box and 
click “Next”. In the second dialog box, set the column widths as desired, but 
the default is usually acceptable. Click on “Next” again.  In the third dialog box, 
make sure the column data format is set to “General”, and click “Finish”. This 
separates the data into columns for manipulation and removes symbols such 
as the plus signs from the numbers. Once the data is in this format, it can be 
graphed or manipulated as desired.

For extended term data capture see: “Sending a Simple Script to 
HyperTerminal®” on page 38.
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Data Format:

The data stream on the screen represents the flow parameters of the main 
mode in the units shown on the display. For L-Series Flow Meters, there are 
three columns of data. The first column is line pressure (normally in psig and 
only in units equipped with the optional pressure sensor), the second column 
line temperature (normally in °C), and the third column is the volume flow rate 
in the units specified at time of order and shown on the display.

 
+014.70  +025.00  +4.123
+014.70  +025.00  +4.123
+014.70  +025.00  +4.123
+014.70   +025.00  +4.123
Pressure Temp Vol. Flow
L-Series Water Flow Meter Data Format

For LC-Series Flow Controllers, there are four columns of data representing 
pressure, temperature, volume flow and set-point. The first column is line 
pressure (normally in psig and only in units equipped with the optional pressure 
sensor), the second column is temperature (normally in °C), the third column 
is volume flow rate (in the units specified at time of order and shown on the 
display), and the fourth column is the set-point (also in the units specified at 
time of order and shown on the display). For instance, if the meter was ordered 
in units of ccm, the display on the meter would read 2.004 ccm and the last two 
columns of the output below would represent volume flow and set-point in ccm 
respectively.

 
+014.70  +025.00  +02.004  02.004
+014.70  +025.00  +02.005  02.004
+014.70  +025.00 +02.006   02.004
+014.70  +025.00  +02.005  02.004
Pressure Temp Vol. Flow Set-Point
LC-Series Water Flow Controller Data Format

Note: On units with the totalizer function a fourth column (meters) or fifth 
column (controllers) will show the totalizer value
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Sending a Simple Script File to HyperTerminal®

It is sometimes desirable to capture data for an extended period of time. 
Standard streaming mode information is useful for short term events, however, 
when capturing data for an extended period of time, the amount of data 
and thus the file size can become too large very quickly. Without any special 
programming skills, you can use HyperTerminal® and a text editing program 
such as Microsoft® Word® to capture text at defined intervals.

1. Open your text editing program, MS Word for example.

2. Set the cap lock on so that you are typing in capital letters.

3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using 
MS Word, you can tell how many lines you have by the line count at the bottom 
of the screen. The number of lines will correspond to the total number of times 
the flow device will be polled, and thus the total number of lines of data it will 
produce.
For example:	 A

	 A
	 A
	 A
	 A
	 A
will get a total of six lines of data from the flow meter, but you can 
enter as many as you like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select 
save. In the save dialog box, enter a path and file name as desired and in the 
“Save as Type” box, select the plain text (.txt) option. It is important that it be 
saved as a generic text file for HyperTerminal to work with it.

5. Click Save.

6. A file conversion box will appear. In the “End Lines With” drop down box, 
select CR Only. Everything else can be left as default.

7. Click O.K.

8. You have now created a “script” file to send to HyperTerminal. Close the file 
and exit the text editing program.

9. Open HyperTerminal and establish communication with your flow device as 
outlined in the manual.

10. Set the flow device to Polling Mode as described in the manual. Each time 
you type A<Enter>, the meter should return one line of data to the screen.

11. Go to the File menu in HyperTerminal and select “Properties”.

12. Select the “Settings” tab.
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13. Click on the “ASCII Setup” button.

14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will 
tell the program how often to read a line from the script file you’ve created. 
1000 milliseconds is one second, so if you want a line of data every 30 seconds, 
you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the 
Properties dialog box.

16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).

17. Browse and select the text “script” file you created.

18. Click Open.

19. The program will begin “executing” your script file, reading one line at 
a time with the line delay you specified and the flow device will respond by 
sending one line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual 
under “Collecting Data”. You will be simultaneously sending it a script file and 
capturing the output to a separate file for analysis.

FLOW MEASUREMENT OPERATING PRINCIPLE

All L or LC-Series Water Flow Meters/Controllers accurately determine the 
flow rate by creating a pressure drop across a unique internal restriction, 
known as a Laminar Flow Element (LFE), and measuring differential pressure 
across it. The restriction is designed so that the water molecules are forced to 
move in parallel paths along the entire length of the passage; hence laminar 
(streamline) flow is established for the entire range of operation of the device. 
Unlike other flow measuring devices, in laminar flow meters the relationship 
between pressure drop and flow is linear. 

In order to have an accurate reading of the flow rate, the absolute viscosity of 
the fluid must be established. The rate at which liquids change viscosity with 
changes in temperature is not linear. The relationship between temperature 
and viscosity for water is well established and Alicat Scientific L and LC-Series 
units utilize a high accuracy temperature sensor and this relationship to provide 
an accurate viscosity reference. For this reason, these meters and controllers 
are generally recommended only for use with pure water. Any additives to 
water (such as antifreeze or disinfectants) that might affect the viscosity should 
be avoided. 

Please visit the Alicat web site for a detailed explanation this principle.
http://www.alicat.com/technical-information/theory-of-operation/
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SUPPORTED UNITS: This device supports many different units. You may select the desired units 
(see page 28). Note that only units appropriate to this device are available for selection.

Pressure Units
Absolute Gauge Differential Notes

PaA PaG PaD pascal
hPaA hPaG hPaD hectopascal
kPaA kPaG kPaD kilopascal
MPaA MPaG MPaD megapascal
mbarA mbarG mbarD millibar
barA barG barD bar

g/cm2A g/cm2G g/cm2D gram force per square centimeter
kg/cmA kg/cmG kg/cmD kilogram force per square centimeter

PSIA PSIG PSID pound force per square inch
PSFA PSFG PSFD pound force per square foot

mTorrA mTorrG mTorrD millitorr
torrA torrG torrD torr

mmHgA mmHgG mmHgD millimeter of mercury at 0 C
inHgA inHgG inHgD inch of mercury at 0 C

mmH2OA mmH2OG mmH2OD millimeter of water at 4 C (NIST conventional)
mmH2OA mmH2OG mmH2OD millimeter of water at 60 C
cmH2OA cmH2OG cmH2OD centimeter of water at 4 C (NIST conventional)
cmH2OA cmH2OG cmH2OD centimeter of water at 60 C
inH2OA inH2OG inH2OD inch of water at 4 C (NIST conventional)
inH2OA inH2OG inH2OD inch of water at 60 C

atm atmosphere
m asl meter above sea level (only in /ALT builds)
ft asl foot above sea level (only in /ALT builds)

V volt; no conversions are performed to or from other units
count count count setpoint count, 0 – 64000

% % % percent of full scale

Flow Units
Volumetric Standard Normal Notes

uL/m SuL/m NuL/m microliter per minute
mL/s SmL/s NmL/s milliliter per second

mL/m SmL/m NmL/m milliliter per minute
mL/h Sml/h NmL/h milliliter per hour

L/s SL/s NL/s liter per second
LPM SLPM NLPM liter per minute
L/h SL/h NL/h liter per hour

US GPM US gallon per minute
US GPH US gallon per hour

CCS SCCS NCCS cubic centimeter per second
CCM SCCM NCCM cubic centimeter per minute

cm3/h Scm3/h Ncm3/h cubic centimeter per hour
m3/m Sm3/m Nm3/m cubic meter per minute
m3/h Sm3/h Nm3/h cubic meter per hour
m3/d Sm3/d Nm3/d cubic meter per day
in3/m Sin3/m cubic inch per minute
CFM SCFM cubic foot per minute
CFH SCFH cubic foot per hour

kSCFM 1000 cubic feet per minute
count count count setpoint count, 0 – 64000

% % % percent of full scale
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Totalizer Units
Volumetric Standard Normal Notes

uL SuL NuL microliter
mL SmL NmL milliliter
L SL NL liter

US GAL US gallon
cm3 Scm3 Ncm3 cubic centimeter
m3 Sm3 Nm3 cubic meter
in3 Sin3 cubic inch
ft3 Sft3 cubic foot

kSft3 1000 cubic feet

uP micropoise, a measure of viscosity; no conversions are performed to or from 
other units

Temperature Units
Label Notes

°C degree Celsius
°F degree Farenheit
K Kelvin
°R degree Rankine

Time Units
Label Notes
h:m:s Displayed value is hours:minutes:seconds

ms millisecond
s second

m minute
hour hour
day day

Valve Drive Units
Label Notes
count +/- 65536 at full drive

% Percent of full scale drive
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TROUBLESHOOTING
Display does not come on or is weak.
Check power and ground connections and supply voltage. Please reference 
the technical specifications (page 51-56) to assure you have the proper power 
for your model.
Flow reading is approximately fixed either near zero or near full scale regardless of 
actual line flow.
Differential pressure sensor may be damaged. A common cause of this problem 
is instantaneous application of high pressure as from a snap acting solenoid 
valve upstream of the meter. If you suspect that your pressure sensor is 
damaged please discontinue use of the device and contact Alicat.
Displayed volumetric flow, pressure or temperature is flashing and message 
VOV, POV or TOV is displayed:
Our flow meters and controllers display an error message (VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) when 
a measured parameter exceeds the range of the sensors in the device. When 
any item flashes on the display, neither the flashing parameter nor the flow 
measurement is accurate. Reducing the value of the flashing parameter to 
within specified limits will return the unit to normal operation and accuracy. If 
the unit does not return to normal contact Alicat.
Meter reads negative flow when there is a confirmed no flow condition.
This is an indication of an improper tare. If the meter is tared while there is 
flow, that flow is accepted as zero flow. When an actual zero flow condition 
exists, the meter will read a negative flow. Simply re-tare at the confirmed 
zero flow condition. Also note that while the meter is intended for positive 
flow, it will read negative flow with reasonable accuracy (it is not calibrated for 
bi‑directional flow) and no damage will result. See TARE page 19 .
After installation, there is no flow.
LC-Series controllers incorporate normally closed valves and require a set-point to 
operate. Check that your set-point signal is present and supplied to the correct pin 
and that the correct set-point source is selected under the SETPT SOURCE list in 
the control set up display (page 28). Also check that the unit is properly grounded.
My controller does not respond to the set-point.
Check that your set-point signal is present and supplied to the correct pin and 
that the correct set-point source is selected under the SETPT SOURCE list in the 
control set up display (page 28). Also check that the unit is properly grounded.
The flow lags below the set-point.
Be sure there is enough pressure available to make the desired flow rate. If 
either the set-point signal line and/or the output signal line is relatively long, it 
may be necessary to provide heavier wires (especially ground wiring) to negate 
voltage drops due to line wire length. An inappropriate PID tuning can also 
cause this symptom if the D term is too large relative to the P term (page 30). 
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Meter does not appear to be accurate when compared against another valid 
measurement of the physical flow (such as weight over time).
Water flow meters can normally be compared against one another provided 
there are no leaks between the two meters. One common cause of inaccuracy, 
inconsistency, or unusual readings is air bubbles trapped in one or both of the 
legs of the differential pressure sensor. Bleed the ports as described in this 
manual to remove this possibility (See page 11). Another possibility is that the 
water has some contaminant or additive, such as antifreeze, that affects the 
viscosity of the water. A third possibility is an improper tare error (see page 19).
Controller is slow to react to a set-point change or imparts an oscillation to the flow.
An inappropriate PID tuning can cause these symptoms. Use at conditions 
considerably different than those at which the device was originally set up can 
necessitate a re-tuning of the PID loop (page 30).
Flow flutters or is jumpy.
The meters are very fast and will pick up any actual flow fluctuations such 
as from a diaphragm pump, etc. Also, inspect the inside of the upstream 
connection for debris such a Teflon tape shreds. Note: L & LC-Series devices 
feature a programmable geometric running average (GRA) that can aid in 
allowing a rapidly fluctuating flow to be read. Please see “Pressure Averaging” 
and “Flow Averaging” on page 22.
The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter 
as voltage drops in the wires increase with distance. Using heavier gauge wires, 
especially in the ground wire, can reduce this effect.
My controller oscillates wildly and/or exhibits very different reactions to the set-
point than I expect.
Conditions considerably different than those at which the device was originally 
set up can necessitate a re-tuning of the PID loop. Avoid long runs of small 
diameter tubing in the system, increase line size.
RS-232 / RS-485 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the port 
on the computer to which the meter is connected is active. Confirm that the port 
settings are correct per the RS-232 / RS‑485 instructions in this manual (Check the 
RS-232 / RS-485 communications select screen for current meter readings). Close 
HyperTerminal® and reopen it. Reboot your PC. See pages 14, 15 and 32 for more 
information on RS-232 / RS-485 signals and communications.
Slower response than specified.
L-Series Meters and LC-Series Controllers feature a programmable Geometric 
Running Average (GRA). Depending on the full scale range of the meter, it 
may have the GRA set to enhance the stability/readability of the display, 
which would result in slower perceived response time. Please see “Pressure 
Averaging” and “Flow Averaging” on page 22.
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Jumps to zero at low flow.
L-Series Meters and LC-Series Controllers feature a programmable zero 
deadband. The factory setting is usually 0.5% of full scale. This can be adjusted 
between NONE and 6.3% of full scale. See page 22.

MAINTENANCE AND RECALIBRATION
General: L and LC-Series Water Flow Meters and Controllers require minimal 
maintenance. The primary cause of damage and/or long-term inaccuracy in 
these devices is contamination and/or corrosion damage. Water should be 
filtered for particulates or biological materials that may grow in the device. 
When removing these units from the line for any extended period of time, 
make an effort to remove all of the water from the device, as deposits of 
calcium or other soluble minerals can affect the accuracy of the device.

Recalibration: The recommended period for recalibration is once every year. A 
label located on the back of the device lists the most recent calibration date. 
The device should be returned to the factory for recalibration within one year 
from the listed date. Before calling to schedule a recalibration, please note the 
serial number on the back of the meter. The Serial Number, Model Number, and 
Date of Manufacture are also available on the Model Info screen (page 24).

Cleaning: L and LC-Series Flow Meters/Controllers require no periodic cleaning. 
If necessary, the outside of the meter can be cleaned with a soft dry cloth. 
Avoid excess moisture or solvents.

For repair, recalibration or recycling of this product, contact:

Alicat Scientific, Inc.
7641 N Business Park Drive

Tucson, Arizona 85743
USA

Ph. 520-290-6060
Fax 520-290-0109

E-mail: info@alicat.com
Web site: www.alicat.com

CCM CCH LPM LPH CFM CFH
CFH 0.0021 0.00003 2.1189 0.035 60.0 1.0
CFM 0.000035 0.0000005 0.035 0.00059 1.0 0.0166
LPH 0.06 0.001 60.0 1.0 1699.0 28.316
LPM 0.001 0.000017 1.0 0.0166 28.316 0.4719
CCH 60.0 1.0 60000.0 1000.0 1699011.0 28317.0
CCM 1.0 0.0167 1000.0 16.667 28317.0 471.947

Flow Conversion Table:
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Option: Totalizing Mode 
Meters and controllers can be purchased with the Totalizing Mode option. For 
controllers this option adds an additional mode screen that displays the total 
flow (normally in the units of the main flow screen) that has passed through the 
device since the last time the totalizer was cleared. The Totalizing Mode screen is 
accessed by pushing the TOTAL button on the MAIN display. 
TOTAL/TIMER: Pushing the TOTAL/TIMER button will cycle the large numbers on the 

display between total mass and time elapsed.
Rollover – The customer can also specify at the 
time of order what the totalizer is to do when 
the maximum count is reached. The following 
options may be specified:
No Rollover – When the counter reaches the 
maximum count it stops counting until the 
counter is cleared.
Rollover – When the counter reaches the maximum 
count it automatically rolls over to zero and 
continues counting until the counter is cleared.
Rollover with Notification – When the counter 
reaches the maximum count it automatically 

rolls over to zero, displays an overflow error, and continues counting until the 
counter is cleared.
TOTAL MASS: The counter can have as many as seven digits. At the time of order, 
the customer must specify the range. This directly affects the maximum count. For 
instance, if a range of 1/100ths of a liter is specified on a meter which is totalizing in 
liters, the maximum count would be 99999.99 liters. If the same unit were specified 
with a 1 liter range, the maximum count would be 9999999 liters.
ELAPSED TIME: The small numbers below the mass total show the elapsed time 
since the last reset in hours, minutes and seconds. The maximum measurable 
elapsed time is 9999 hours 59 minutes 59 seconds. The hours count resets when 
RESET is pushed, an RS-232 or RS-485 clear is executed or on loss of power. Press 
TOTAL/TIMER to show this as the primary display.
PEAK (Meters Only): PEAK will display the most recent peak flow rate until 
totalizer is reset.
SETPT (Controllers Only): Pushing SETPT will allow you to change the controller's 
set-point.
RESET – The counter can be reset to zero at any time by pushing the RESET 
button. To clear the counter via RS-232 or RS-485, establish serial communication 
with the meter or controller as described in the RS-232 or RS-485 section of the 
manual. To reset the counter, enter the following commands:

In Polling (addressable) Mode:  Address$$T <Enter>  (e.g. B$$T <Enter>)

SETPT
+123.4

MENU

SCCM
+123.4

TOTAL/
TIMER

BATCH RESET

0000:09:59    SCC
00123.45
00123.45 Batch Done

When using a mass flow controller as an absolute pressure controller, 
the mass flow rate may momentarily exceed the flow measurement 
capability (full scale + 28%) of the unit. This may occur when the unit is 
asked to make an abrupt pressure change. 

If the totalizer is in use at that time, the totalized value will necessarily become 
incorrect. Please reset the totalizer if such an ‘over-flow’ condition has occurred.  



46

BATCH PROCESSING MODE – CONTROLLERS ONLY
Batch mode is a function within the optional Totalizing mode. Batch mode is 
designed to provide repeatable, finite flow quantities. 

To activate Batch Mode: Press BATCH. Then use 
SELECT DIGIT to move the arrow to the desired digit, 
and the UP and DOWN buttons to change the value. 
Press CLEAR to return to zero. Press SET to record 
your value. If the controller has a non-zero Set-Point, 
flow will start immediately. If not, press SETPT to 
select a Set-Point.
Batch values can also be established via RS‑232/RS‑485 
communication using Register 92. (See RS-232/RS-485 
Section of this manual for serial communication methods.)
Note: While the Totalizer counter will still reset across 

power cycles, the Batch process value is stored in EEPROM and will remain valid 
until updated by the user.
While the Batch is processing, the remaining amount of the Batch  value is 
displayed above REMAIN on the Totalizer screen. Time elapsed during the Batch 
processing is displayed below the totalizing counter. Press TOTAL/TIMER to 
toggle these values.  
When the active Totalizer reaches the preset Batch value, flow ceases, and 
REMAIN updates to Done Batch. The Totalizer timer also pauses. 

- To start a new batch of the same size, simply press 
RESET. The Totalizer can reproduce any number of 
fixed Batches in this manner. 
- To start a smaller batch, decrease the Batch value. 
The new batch begins when you press RESET. 
- To continue the existing batch to a larger total 
volume, increase the Batch value. Flow resumes as 
soon as you press OK in the Batch Value screen.
- To start a larger batch from scratch, first clear the 
flow Set-Point to zero to prevent unwanted flow. 

Then increase the Batch value, and select a flow Set-Point. Flow will begin when 
you press SET in the Set-Point screen.
- To cancel a batch in progress, clear the Set-Point and press SET.
Note: Batch mode operates independently of the desired flow rate, but requires 
a non-zero flow rate to run. The rate of flow is determined by the controller 
Set-Point value, which is established by the user via analog, front panel or serial 
communication methods. Batches can be produced more slowly or more rapidly 
as determined by the user-selected Set-Point flow rate.
To turn off Batch Mode: Set the Batch value to zero (0.0) via the front panel or 
RS-232/RS-485 communication using Register 92. If there is a non-zero flow Set-
Point, flow will immediately resume, and the Totalizer counter will continue per 
the user established Set-Point flow rate.

DOWN

SET

SELECT 
DIGIT

UP

BACK/ 
CANCEL CLEAR

˄
00123.45

SETPT
123.4

MENU

SCCM
+123.4

TOTAL/ 
TIMER

+100
REMAIN RESET

4:14 h:m:s

Scm3

00123.45

Batch Size: Scm3
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Alicat Portable Meters and Gauges
Alicat Rechargeable Flow Meters and Pressure Gauges use a Li-Ion 3.7V cell located in the top 
section of the device. The Li-Ion cell must not be removed.
Normal battery life of a fully-charged cell is 18 hours with a monochrome display or  
5 hours with a TFT color display, when the backlight is set to 10. Dimming the backlight 
will increase battery life.
The battery can be charged through either the micro-USB port or the mini-DIN connector. 
When the device is connected to external power it will function normally while the battery 
is charging. Note: If the battery has no charge, a charge time of one minute will be required 
before the unit can be turned on. Charge rates will be fastest through the micro-USB port 
using the included power supply or equivalent. The device will charge fastest when it is 
turned off. 
Recharge Time: 3.5 hours with 2A USB supply. The micro-USB port is for charging purposes only.
The green/red indicator LED on top of the device will light up green to indicate that the 
unit is charging. The green LED will turn off when the battery is charged and the power 
switch is turned to “I” for ON. 
A small lightning bolt symbol will display next to the battery symbol while the device is 
charging. it will no longer appear when the device is fully charged.
The indicator LED flashes red when the device has about 1 hour of battery life remaining. The 
LED will flash red at a faster rate when the device has about 15 minutes of battery life remaining.  
It is highly recommended that the device be charged immediately. When the battery charge runs 
out, the display contrast will turn to 0 and device performance is no longer guaranteed.

Output signals from the meter are passed through the mini-DIN connector on top 
of the device. Rechargeable battery units do not support 0-10V analog output.  
Receiver resistance must be below 250Ω.

Turn the power switch on top of the device to “O” for OFF when it is not in use.
Warning: If the device is left ON until the battery can no longer power it, the 
charge indicator will fall out of sync with the actual charge. The device can be 
re-synced by fully charging the battery once.

A Battery Charge Indicator appears below Tare on the display.

CAUTION! Do not operate or store the device outside of the -10° 
to +50°C temperature range. If internal sensors detect that the 
temperature is outside of this range, the display contrast will turn to 0 
and the meter’s performance is no longer guaranteed. 

The safe charging temperature range is 0° to +45°C. If internal sensors detect 
temperatures outside of this range, the battery will not charge.

#C
+21.50

+0.000
CCM MENU

TARE VPSIA
+13.60

+0.000
SCCM

95 – 100%

80 – 95%

50 – 80%

20 – 50%

5 – 20%

0 – 5%

TOP VIEW OF DEVICE

Green = Charging
Flashing Red = Low Battery

+5 Vdc
Charge Only

1 2

3 4 5

6 7 8 I  
 O

On / Off 
I / O
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Pressure Menu for Portable Meters 
Alicat portable meters are programmed with additional pressure read options. 
Pressing the pressure button once (upper left) will move the pressure reading 
to the main display. Pressing the button a second time will open a menu of 
pressure read options. Scroll UP or Down and press Select to make a change.

When the pressure button is already using the 
device engineering units, the bottom menu 
option displays as “Set device eng units”.
When the pressure button is using something 
different than device engineering units (e.g., 
bar instead of PSI), the bottom menu option 
displays as “Show device units”.
The serial data line changes only when device 
engineering units are changed, and the 
instrument will prompt you to accept these 
changes to the serial line.

TARE P w/BARO: The stream absolute pressure sensor can be tared to the 
barometric pressure sensor. In this case, the absolute pressure is offset by the 
differential between the two readings. TARE P w/BARO can be accessed from the 
MISC2 display.

#C
+21.50

+0.000
CCM

MENU/
TOTAL

TARE VPSIA
+13.60

+0.000
SCCM

+13.60
Abs Press

DOWN

CANCEL SELECT

>Show abs pressure
  Show gauge pressure
  Show baro pressure
  Set button eng units
  Set device eng units

UP

PSIA
Ait

DOWN

CANCEL SELECT

>Show abs pressure
  Show gauge pressure
  Show baro pressure
  Set button eng units
  Show device units

UP

DIAG
TEST

BACK
TARE P
w/BARO MAIN

STP/
NTP

ROTATE 
DISP VENT TO ATMOSPHERE

WITH NO FLOW BEFORE 
PRESSING SET.

Current absolute  
sensor offset:

+0.000 barG
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Option: Remote Electronics for High Line or Gas Temperatures

Some applications involve operating 
temperatures outside the standard Alicat 
device specifications. A solution using 
remote electronics is available. (This option is 
not applicable for liquid devices.)

The flow body’s components are minimized 
to only the required sensors. The flow data is 
sent to the microprocessor electronics up to 
6 feet away from the sensor package. 

Relocating the sensitive electronics allows 
for installation of the flow body in ambient 
temperatures as high as 85° Celsius with gas temperatures under 100°Celsius. 

In these applications we recommend our custom gauge calibration at a 
gas temperature of up to 70°Celsius. This will reduce zero shift errors that 
occur when actual gas flow temperatures deviate substantially from the gas 
calibration temperature. 

This configuration is also used in integrations that require a compact flow 
package at the installation point.

Option: Remote Panel Display 

Our Remote Display option offers the flexibility of using 
Alicat’s display with units that are embedded inside 
processes or instrument enclosures. 

The Remote Display retains all of the same features as our 
standard display.

The Remote Display is ideal for:

●  OEMs Remote Panel Mounting	 ●  Embedded Systems

●  Gas Panels			   ● Fuel Cell Test Stations

●  Leak Detection Systems		 ●  Artificial Environments
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Accessory: BB9 Multi-Drop Box

The BB9 Multi-Drop Box makes it convenient to wire 
multiple flow and/or pressure devices to a single RS‑232 or 
RS-485 port. Now with an RS-232 to USB interface!

The Multi-Drop Box has nine 8 pin Mini-DIN ports available. 
The ports are to be used with a standard double ended 8 
pin Mini-DIN (DC-62) style cable going from the box to each 
flow or pressure device. (The BB9 can also be ordered with 
locking industrial connectors.)

A single DB9 D-SUB type connector (COM PORT) connects, using the included 
cable, to the serial connector on a PC or laptop. 

All of the flow and/or pressure devices are powered via a terminal block on the 
front of the box. 

If more than nine devices will be required, additional Multi-Drop Boxes can be 
daisy chained together with a double ended 8 pin Mini-DIN cable plugged into 
any receptacle on both boxes.

BB9 Power Supply for Large Valve Controllers: The PS24VHC (Power Supply 
24Vdc High Current) is a 6.5Amp 24Vdc power supply designed for running 
multiple large controllers on a BB9. 

The 6.5Amp power supply can run as many as 8 large valve controllers, which 
makes it ideal for the BB9 and multiple large valve (or small valve / large valve 
combination) controllers on a BB9.

BB-9 Multi-Drop 
BoxØ .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

3.46

6.75 1.55

5.06

BB9 Multi-Drop Box

Ø .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

Ø .175 Thru 2 PL

3.46

6.75 1.55

5.06

6.75

7.56
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Accessory: Flow Vision™ SC Software
Flow Vision™ SC is an intuitive software interface to help your test 
cycles run smoother and shorten your engineering time! 

Flow Vision™ SC lets you connect to and communicate with multiple Alicat 
units simultaneously. Now you can view virtual displays, control tabs, charts 
and data lines from every connected Alicat device on the same screen.

Flow Vision™ SC supports all RS-232 and RS-485 Serial communication 
functions, including: gas selection, tareing, set‑point control, valve tuning 
and flow averaging.
Session Saving: Save and reload your configuration data with confidence. 
Script Building: Create scripts to adjust a controller’s set-point value at 
variable specified time intervals.
Charting: Chart as many parameters as you want off as many devices as you 
want, with color coding, zooming, and printing functionality.
Alarms: Create software alarms that will notify you of given parameter conditions.
Data Capture & Logging: Capture and log data to either a .csv file or a .txt file. 
Improved Data Logging and Data Log File Splitting for easy to manage data.

Accessory: Flow Vision™ MX Software
Alicat’s New Flow Vision™ MX software gives you an easy way to do  
GAS BLENDING using Alicat Mass Flow Controllers and your own PC. 

Flow Vision™ MX software is a simple way to connect up to six Alicat 
mass flow controllers and create your own gas mix concentrations.

Using our inexpensive BB9-232 and a single USB connection you can: 

•	 Create your own gas blends 
•	 Adjust flow rates 
•	 Save your specific blend formulas.

All the controllers can be powered through the BB9-232 with a single 
power supply.

Just connect your unique gases to each controller, select the gas type either 
locally on the controller or through Flow Vision™ MX, manifold the flow 
outputs and create your gas mix.
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Accessories
Part Number Description

FLOWVISIONSC Flow Vision™ SC software for interface with all Alicat instruments

FLOWVISIONMX Flow Vision™ MX software for gas blending

BB9-232 9 position Multi Drop Box with 9-pin serial port and USB to PC

BB9-I 9 position Multi-Drop Box, Industrial connectors

BB9-485 9 position Multi Drop Box with serial port only

BB9-I-485 9 position Multi-Drop Box, industrial connectors, serial port only

PVPS24U Universal 100-240 VAC to 24 Volt DC Power Supply Adapter

PS24VHC High current power supply for BB9 use with Large Valve Controllers

PVPS5USBU micro-USB to wall adapter

PCASE Industrial carry and storage case for up to 2 portable meters/gauges

PCASE-L Industrial carry and storage case for up to 6 meters and controllers

DC-61 8 Pin Male Mini-DIN connector cable, single ended, 6 foot length

DC-6RT 8 Pin Male Right Angle Mini-DIN Cable, single ended, 6 foot length

DC-251 8 Pin Male Mini-DIN connector cable, single ended, 25 foot length

DC-501 8 Pin Male Mini-DIN connector cable, single ended, 50 foot length

DC-751 8 Pin Male Mini-DIN connector cable, single ended, 75 foot length

DC-1001 8 Pin Male Mini-DIN connector cable, single ended, 100 foot length

DC-32RS 8-pin Male Mini-DIN connector cable, double ended, no analog, 3 
foot length

DC-62RS 8-pin Male Mini-DIN connector cable, double ended, no analog, 6 
foot length

DC-62 8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
DC-252 8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
DC-502 8 Pin Male Mini-DIN connector cable, double ended, 50 foot length

MD8DB9 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length

DBC-251 DB15 cable, single ended, 25 foot length

510199 DB9 cable, double-ended female, 3 meter length

IC10 Industrial cable, 6 Pin, single ended, 10 foot length

IC20 Industrial cable, 6 Pin, single ended, 20 foot length

IC50 Industrial cable, 6 Pin, single ended, 50 foot length

IC-102 Industrial cable, 6 pin double ended, 10 foot length

USB-RS232 RS-232 to USB Converter
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MNPT to Compression Fittings
10-32 - 1/8” SS-200-1-0157
10-32 - 1/4” SS-400-1-0256
1/8” - 1/8” SS-200-1-2
1/8” - 1/4” SS-400-1-2
1/8” - 3/8” SS-600-1-2
1/8” - 1/2” SS-810-1-2
1/8” - 3mm SS-3M0-1-2
1/8” - 4mm SS-4M0-1-2
1/8” - 6mm SS-6M0-1-2
1/8” - 8mm SS-8M0-1-2

1/8” - 12mm SS-12M0-1-2
1/4” - 1/8” SS-200-1-4
1/4” - 1/4” SS-400-1-4
1/4” - 3/8” SS-600-1-4
1/4” - 1/2” SS-810-1-4
1/4” - 3mm SS-3M0-1-4
1/4” - 4mm SS-4M0-1-4
1/4” - 6mm SS-6M0-1-4
1/4” - 8mm SS-8M0-1-4

1/4” - 12mm SS-12M0-1-4
1/2” - 1/8” SS-200-1-8
1/2” - 1/4” SS-400-1-8
1/2” - 3/8” SS-600-1-8
1/2” - 1/2” SS-810-1-8
1/2” - 3/4” SS-1210-1-8
1/2” - 6mm SS-6M0-1-8
1/2” - 8mm SS-8M0-1-8

1/2” - 12mm SS-12M0-1-8
1/2” - 16mm SS-16M0-1-8
3/4” - 1/4” SS-400-1-12
3/4” - 1/2” SS-810-1-12
3/4” - 3/4” SS-1210-1-12

3/4” - 12mm SS-12M0-1-12
3/4” - 16mm SS-16M0-1-12

Filters & Elements FNPT-MNPT
10-32 5μ 510053

10-32 20μ 510054
1/8” 20μ ILF-1/8-20
1/4” 40μ ILF-1/4-40
1/2” 40μ ILF-1/2-40*
3/4” 40μ ILF-3/4-40*

20μ element ILFE20
40μ element ILFE40
40μ element ILFE40L*

Filters & Elements FNPT-FNPT*
10-32 5μ CF-303-20-316

*requires MNPT to MNPT coupler to 
interface with Alicat flow bodies

10-32 Male UNF to 1/8 FNPT Adapter

410133

Male M5 (10-32) Buna-N O-ring face seal 
to 1/8”Female NPT

Accessories
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Technical Data for Alicat L - Series Water Flow Meters
0 – 0.5 ccm Full Scale through 0 – 10 lpm Full Scale

Alicat L-Series water flow meters read both water flow and water temperature. An optional 
pressure sensor is also available.
Standard Specifications (Contact Alicat for available options.)

Performance L Meters
Available Ranges 0.5 ccm to 10 lpm

Accuracy at calibration conditions after 
tare ± 2% Full Scale

Repeatability ± 2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 2% to 100% Full Scale / 50:1 Turndown
Maximum Flow Rate 128% FS Measurable

Typical Response Time 20 ms (Adjustable)
Warm-up Time < 1 Second

Operating Conditions L Meters
Operating Temperature +10 to +50 ºCelsius

Maximum Pressure 200 psig
Mounting Attitude Sensitivity None

Ingress Protection IP40

Wetted Materials 302 & 303 Stainless Steel, 316L Stainless Steel, Viton®. 
If your application demands a different material, please contact Alicat.

Communication / Power L Meters
Monochrome LCD or Color TFT Display 

with integrated touchpad
Simultaneously displays Flow and Temperature   

(optional Pressure sensor available)
Digital Output Signal1 Options RS-232 Serial / RS-485 Serial / PROFIBUS3 

Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  
Optional Secondary Analog Output 

Signal2
0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 

Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking
Supply Voltage 7-30 Vdc   (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.040 Amp

1. The Digital Output Signal communicates Flow and Temperature  (optional Pressure sensor available) 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Flow 

or Temperature
3. If selecting PROFIBUS, no analog signal is available. PROFIBUS units do not have the display. See PROFIBUS 

specifications for PROFIBUS supply voltages and currents. (www.alicat.com/profibus)

Range Specific Specifications
L Meters 

 Full Scale Flow
Pressure Drop1 at 

FS Flow (PSID)
Mechanical 
Dimensions Process Connections2

0.5 ccm to 1 ccm 2.0 4.4”H x 2.4”W x 1.1”D M5 (10-32) Female Thread3

2 ccm to 500 ccm 2.0
4.6”H x 2.4”W x 1.1”D 1/8” NPT Female 

1 lpm 4.0
2 lpm 4.0 4.7”H x 2.7”W x 1.1”D 1/4” NPT Female
5 lpm 10.0

5.1”H x 4.0”W x 1.6”D 1/4” NPT Female
10 lpm 20.0

1. Lower Pressure Drops Available, please contact Alicat.
2. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and SAE 
connections upon request.
3. Shipped with M-5 (10-32) Male Buna-N O-ring face seal to 1/8” Female NPT fittings.
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L-Series:
0 - 0.5 ccm
0 - 1 ccm

L-Series:
0 - 2 ccm
0 - 5 ccm
0 - 10 ccm
0 - 20 ccm
0 - 50 ccm
0 - 100 ccm
0 - 200 ccm
0 - 500 ccm

0 - 1 lpm

0.5 ccm to 1 ccm approximate shipping weight: 1.0 lb

10 ccm to 1 lpm approximate shipping weight: 1.2 lb

8.53mm
.336in

.525in
13.34mm Both Sides

M5X0.8  - 6H

3.81mm
.150in

2.225in
56.52mm

3.18mm
.125in

.925in
23.50mm

2X 8-32 UNC   .175in[4.45mm]

1.050in
26.67mm

8.53mm
.336in

.525in
13.34mm2.375in

60.33mm

4.397in
111.68mm

12/17/2015
REV.
1L-1CCM-D-MSPEC

DATE

.525in
13.34mm

.350in
8.89mm

2.375in
60.33mm

4.567in
116mm

26.67mm
1.050in

12/17/15

REV.
1L-1LPM-D-MSPEC

DATE

13.34mm
.525in

.350in
8.89mm

Both Sides
1/8  NPT

56.52mm
2.225in

.150in
3.81mm 3.18mm

.125in

.925in
23.50mm

2X 8-32 UNC   .350in[8.89mm]
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.800in
20.32mm

.500in
12.70mm

20.32mm
.800in

.500in
12.70mm

Both Sides
1/4  NPT

19.05mm
.750in

3.250in
82.55mm

4.45mm
.175in

1.425in
36.20mm

4X8-32 UNC   .375in[9.53mm]

1.600in
40.64mm

DATE

L-10LPM-D-MSPEC 2

1/8/2016

REV.

4.000in
101.60mm

5.067in
128.70mm








  


















 



L-Series:
0 - 2 lpm

L-Series:
0 - 5 lpm
0 -10 lpm

 2 lpm approximate shipping weight: 1.5 lb

 5 lpm  to 10 lpm approximate shipping weight: 2.6 lb
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Technical Data for Alicat LC & LCR Water Flow Controllers
0 – 0.5  ccm Full Scale through 0 – 5 lpm Full Scale

Alicat LC and LCR-Series water flow controllers display both water flow and water 
temperature. An optional pressure sensor is also available.
Standard Specifications (Contact Alicat for available options.)

Range Specific Specifications

Performance LC Controllers LCR Controllers
Available Ranges 0.5 ccm to 500 ccm 1 lpm to 5 lpm

Accuracy at calibration conditions 
after tare ± 2% Full Scale

Repeatability ± 2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 2% to 100% Full Scale / 50:1 Turndown
Maximum Flow Rate 102.4% FS Controllable

Typical Response Time 100 ms (Adjustable)
Warm-up Time < 1 Second

Operating Conditions LC Controllers LCR Controllers
Operating Temperature +10 to +50 ºCelsius

Maximum Pressure 150 psig
Mounting Attitude Sensitivity None Mount with valve cylinder vertical & upright

Valve Type Normally Closed
Ingress Protection IP40

Wetted Materials

LC, LCR: 430FR Stainless Steel, 302 & 303 Stainless Steel, 316L 
Stainless Steel, Viton®, FFKM. 
LCR Controllers Add 416 Stainless Steel, Delrin®. 
If your application demands a different material, please contact Alicat.

Communication / Power LC Controllers LCR Controllers
Monochrome LCD or Color TFT 

Display with integrated touchpad
Simultaneously displays Flow and Temperature  

(optional Pressure sensor available)

Digital Output Signal1 Options RS-232 Serial / RS-485 Serial / PROFIBUS3 

Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  
Optional Secondary Analog Output 

Signal2
0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 

Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking
Supply Voltage 12-30 Vdc  (15-30 Vdc for 4-20 mA outputs) 24-30 Vdc
Supply Current 0.250 Amp 0.750 Amp

1. The Digital Output Signal communicates Flow and Temperature  (optional Pressure sensor available) 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of 

Flow or Temperature
3. If selecting PROFIBUS, no analog signal is available. PROFIBUS units do not have the display. See 

PROFIBUS specifications for PROFIBUS supply voltages and currents. (www.alicat.com/profibus)

Full Scale Flow Pressure Drop1 at 
FS Flow (PSID)

Mechanical 
Dimensions Process Connections2

LC Controllers
0.5 ccm to 1 ccm 4.4”H x 3.4”W x 1.1”D M5 (10-32) Female Thread3

2 ccm

4.6”H x 3.6”W x 1.1”D 1/8” NPT Female
5 ccm to 50 ccm 5.0

100 ccm 5.0
200 ccm to 500 ccm 7.5

LCR Controllers
1 lpm 4.0

5.7”H x 7.7”W x 2.3”D 1/4”NPT Female2 lpm 4.0
5 lpm 10.0

1. Lower Pressure Drops Available, please contact Alicat.
2. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and SAE 
connections upon request.
3.  Shipped with M-5 (10-32) Male Buna-N O-ring face seal to 1/8” Female NPT fittings.
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LC-Series:
0 - 5 ccm

0 - 10 ccm
0 - 20 ccm
0 - 50 ccm

0 - 100 ccm
0 - 200 ccm
0 - 500 ccm

100 ccm to 500 ccm approximate weight: 1.6 lb

LC-Series
0 - 0.5 ccm
0 - 1 ccm

0.5 ccm to 1 ccm approximate shipping weight: 1.1 lb.

111.68mm
4.397in

3.338in
84.77mm

1.050in
26.67mm

1
REV.

DATE

12/17/2015

LC-1CCM-D-MSPEC

.525in
13.34mm

.336in
8.53mm

Both Sides
M5X0.8  - 6H 

4.93mm
.194in

.525in
13.34mm

23.50mm

3.81mm
.150in.125in

3.18mm

.925in

2.225in
56.52mm

2X 8-32 UNC  .175in[4.45mm]

.150in
3.81mm

23.50mm
.925in

3.18mm
.125in

2.225in
56.52mm

2X 8-32 UNC    .350in[8.89mm]

13.34mm
.525in

.350in
8.89mm

Both Sides
1/8 NPT 

3.588in
91.12mm

116mm
4.567in

1
REV.

DATE

1/8/2016

LC-500CCM-D-MSPEC

1.050in
26.67mm

8.89mm
.350in

.525in
13.34mm
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2
REV.

DATE

1/12/2016

LCR-5LPM-D-MSPEC

57.15mm
2.250in1.600in

40.64mm

194.31mm
7.650in

144.45mm
5.687in

15.75mm
.620in

 .375in[9.53mm]4X 8-32 UNC  

82.55mm
3.250in

.575in
14.61mm

3.075in
78.11mm

.375in
9.53mm

1.875in
47.63mm

4.45mm
.175in

.750in
19.05mm

36.20mm
1.425in

1.125in
28.58mm

28.45mm
1.120in

.800in
20.32mm Both Sides

1/4  NPT

12.70mm
.500in

LCR-Series:
0 - 1 lpm
0 - 2 lpm
0 - 5 lpm

1 lpm to  5 lpm approximate weight: 9.0 lb. 
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Specification Meter  or 
Gauge

Small Valve
Controller

Large Valve
Controller Description

Input /Output Signal Digital PROFIBUS DP

Electrical Connections DB9
Supply Voltage: 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc

Supply Current 80mA @ 12Vdc
65mA @ 24Vdc

295mA @ 12Vdc
280mA @ 24Vdc 780mA @ 24Vdc

Technical Data for PROFIBUS Meters, Gauges and Controllers

NOTICE: The following specifications are applicable to Alicat PROFIBUS enabled meters, 
gauges and controllers only. 
All other operating specifications are shown in the Technical Data page for standard Alicat 
instruments.
All standard device features and functions are available and operate in accordance with the 
standard Alicat Scientific device operating manual provided with the device.

Power and Signal Connections:
Connect to the device using two DB9 
connectors.
The female top connection is PROFIBUS. 
The male connection on the side is power and 
RS‑232 or RS-485.
Pin out diagrams for all PROFIBUS enabled 
Alicat devices are shown:

PROFIBUS MC1SLPM shown to provide PROFIBUS connector dimensions only. Flow 
body and valve dimensions will vary with range. Please see Alicat’s device specifications for 
complete dimensions. 

PROFIBUS units do not have a display screen.

2 x 8-32 UNC ┬v  .350

.525

.35

4.264.08

3.76

3.59

1/8 NPT
Both Sides

1.05

.525

.35

2.225
.150 .125

.925

MC-1SLPM-PROFIBUS

1. NC
2. OPT GND
3. DP
4. RTS
5. DGD
6. VP
7. OPT 7 to 30VDC
8. DN
9. NC

5 1
9 6

TOP

1. NC
2. RS232RX
3. RS232TX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

SIDE
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Eight Pin Mini-DIN Connector Pin-Outs
If your Alicat Instrument was ordered with the standard Eight Pin Mini-DIN 

connection, please be sure to reference the following pin-out diagram.

Standard 8 Pin Mini-DIN Pin-Out



 







1 2

3 4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Inactive (or optional 4-20mA Primary Output Signal) Black

2 Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS-232RX / RS-485(–) Input Signal (receive) Red

4 Meters/Gauges = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS-232TX  / RS-485(+) Output Signal (send) Yellow
6 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue

8 Ground (common for power, digital communications, analog signals 
and alarms) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini‑DIN connector. The availability of different output signals depends on the options 
ordered. Optional configurations are noted on the unit’s calibration sheet.
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 














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The above pin-out is applicable to all the flow meters and controllers ordered with the 
industrial connector. The availability of different output signals depends on the flow 
meter options ordered.

Locking Industrial Connector Pin-Outs
If your Alicat Instrument was ordered with a Six Pin Locking Industrial 
connection, please be sure to reference the following pin-out diagram.

Pin Function
1 Power In  ( + )
2 RS-232TX / RS-485(+)
3 RS-232RX / RS-485(-)
4 Meters/Gauges = Remote Tare (Ground to Tare)

Controllers = Analog Set-Point Input
5 Ground (common for power, communications and signals)
6 Signal Out (Voltage or Current as ordered)

Male Connector: Cable Female Connector: Device
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Pin Function
1 Not Connected (4-20mA analog output signal optional)

2 5.12 Vdc or (secondary analog output (4-20mA, 5Vdc, 10Vdc or 
alarm optional)

3 Serial RS-232RX or RS-485(-)

4 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

5 Serial RS-232TX or RS-485(+)
6 0-5 Vdc Output Signal (or 0-10 Vdc optional) 
7 Power In (+Vdc)

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Ground (common for power, digital communications, analog 
signals and alarms)

Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9 connector. The availability of different output signals depends 
on the options ordered. Optional configurations are noted on the unit’s 
calibration sheet.

Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS‑485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

Standard DB9 Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9 equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9 offerings, along with some options for customization.
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If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS‑485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9A Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9A equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9N offerings, along with some options for customization.
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If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.

Pin Function
1 Not Connected 
2 0-5 Vdc Output Signal (or 0-10 Vdc optional)
3 Power In (+Vdc) 

4 Ground (common for power, digital communications, analog 
signals and alarms)

5 Serial RS-232TX or RS-485 (+) 

6 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog 
signals and alarms)

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Serial RS-232RX or RS-485 (-)
Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9A connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS‑485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9N Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9N equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9N offerings, along with some options for customization.
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Pin Function
1 Power In (+Vdc) 

2 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

3 0-5 Vdc Output Signal (or 0-10 Vdc optional) 
4 Not Connected

5 Ground (common for power, digital communications, analog 
signals and alarms)

6 Ground (common for power, digital communications, analog 
signals and alarms)

7 Serial RS-232RX or RS-485 (-)
8 Serial RS-232TX or RS-485 (+)
9 Not Connected

Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9N connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.

If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS‑485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9R Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9R equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9R offerings, along with some options for customization.
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7641 N Business Park Dr.  Tucson, AZ 85743

520-290-6060 Ph.  520-290-0109 Fax



7641 N Business Park Dr.  Tucson, AZ 85743

520-290-6060 Ph.  520-290-0109 Fax

Female Connector Front View

9 9

Male Connector Front View

6

1

6

1 5 5

If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.

Pin Function
1 Serial RS-232TX or RS-485 (+)
2 0-5 Vdc Output Signal (or 0-10 Vdc optional)

3 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers) 

4 Ground (common for power, digital communications, analog 
signals and alarms)

5 Not Connected
6 Serial RS-232RX or RS-485 (-)   
7 Power In (+Vdc) 

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Ground (common for power, digital communications, analog 
signals and alarms)

Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9R connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS‑485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9T Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9T equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9T offerings, along with some options for customization.
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If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.

Pin Function
1 Serial RS-232TX or RS-485 (+) 
2 0-5 Vdc Output Signal (or 0-10 Vdc optional)
3 Power In (+Vdc) 

4 Ground (common for power, digital communications, analog 
signals and alarms)

5 Not Connected

6 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog 
signals and alarms)

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Serial RS-232RX or RS-485 (-)
Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9T connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS‑485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9U Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9U equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9U offerings, along with some options for customization.
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Pin Function
1 Serial RS-232RX or RS-485(-)
2 0-5 Vdc Output Signal (or 0-10 Vdc optional) 
3 Power In (+Vdc)

4 Ground (common for power, digital communications, analog 
signals and alarms)

5 Not Connected

6 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog 
signals and alarms)

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Serial RS-232TX or RS-485(+)
Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9U connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.

If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15 – Pin-Out Alicat Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Ground
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8  Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 RS-232 RX (receive) or RS-485 –
14 Ground
15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 3, 9, 10, and 14 are connected together inside of the device and are 
common grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-Alicat DB15 wire to a DB15 equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

Male Connector Front View Female Connector Front View
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DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15A – Pin-Out “Aalborg XFM” Style

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15A equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

Male Connector Front View Female Connector Front View
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DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.

Pin Number Function
1 Ground
2 Primary Analog Signal Output

3 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*

4 Ground
5 Power Supply Common
6 Ground
7 Power Supply (+Vdc)
8 RS-232 Tx (send) / RS-485 –
9 Ground
10 N/C
11 N/C
12 Secondary Analog Signal Output / fixed 5.12Vdc*
13 N/C
14 N/C
15 RS-232 Rx (receive) / RS-485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
* Added to allow for full use of features on Alicat devices, may not be present on host wiring
NOTE: Pins 1, 4, 5, 6 and 9 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
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DB15B – Pin-Out “Brooks” Style

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15B equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.
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DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 N/C
14 RS-232 RX (receive) or RS-485 –*
15 RS-232 TX (send) or RS-485 +*

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 9,and 10 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring
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DB15K – Pin-Out “MKS” Style

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15K equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

Pin Number Function
1 N/C
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply Common
6 N/C
7 Power Supply (+Vdc)

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Secondary Analog Signal Output / fixed 5.12Vdc *
10 N/C
11 Ground
12 Ground
13 RS-232 RX (receive) or RS-485 – *
14 RS-232 TX (send) or RS-485 + *
15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.



73

DB15H – Pin-Out “Hastings H” Style

Pin Number Function
1 N/C
2 RS-232 RX (receive) or RS-485 – *
3 N/C
4 N/C
5 Ground
6 Primary Analog Signal Output
7 Power Supply Common
8 N/C
9 N/C
10 Secondary Analog Signal Output / fixed 5.12Vdc *
11 Power Supply (+Vdc) 
12 Ground
13 N/C

14 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

15 RS-232 TX (send) or RS-485 + *
Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 7 and 12 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15H equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15O – Pin-Out "Brooks" variant

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15O equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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Pin Number Function
1 Ground
2 N/C
3 N/C
4 Primary Analog Signal Output
5 Power Supply (+Vdc)
6 N/C

7 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*

8 N/C
9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 N/C
14 RS-232 RX (receive) or RS-485 –*
15 RS-232 TX (send) or RS-485 +*

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common 
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring
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DB15S – Pin-Out “Sierra” Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output 
3 N/C
4 N/C
5 Ground
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc *
12 RS-232 RX (receive) or RS-485 – *
13 Power Supply (+Vdc) 
14 RS-232 TX (send) or RS-485 + *
15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 5, 9, 10 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15S equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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Additional Information for Alicat 
CSA and ATEX Approved Devices

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

WARNINGS: 
EXPLOSION HAZARD – DO NOT DISCONNECT WHILE 
CIRCUIT IS LIVE UNLESS AREA IS KNOWN TO BE NON-
HAZARDOUS.

EXPLOSION HAZARD – SUBSTITUTION OF COMPONENTS 
MAY IMPAIR SUITABILITY FOR CLASS I, DIVISION 2.

II 3 G

Alicat CSA / ATEX approved devices are equipped with either a locking 
six pin industrial connector (IC), locking D-sub 15 pin connector (DB15) 
or locking D-sub 9 pin connector (DB9). Please see pages 58 - 70 for the 
correct power and signal connections for each type of connector. 

See the following page for special conditions regarding the use of 
these units!
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USE of Alicat instruments  (L, LC, LCR, M, MW, MS, MC, MCW, MCS, MCR, MCRW, MCRS, 
P, PS, PC, PCS, PCR and PCRS product families only) in Class 1 Division 2 applications.

CSA certifies the use of this product for general use as well as use in hazardous 
locations as defined by Class 1 Division 2 Group A, B, C and D T4. 
 CSA certification is indicated by the product label as shown below and 
not by the statements in this, or any accompanying documentation.

Special Conditions:
To comply with CSA certification the following information is included in the product literature:

•	 When equipment is properly labeled, it is suitable in Class I, Division 2, Group A, B, 
C and D, T4

o	 Tamb. -40°C to +50°C 
•	 Electrical Rating 24Vdc, 0.800A max
•	 Instruments shall be powered by a CSA certified, UL listed, Class II external power 

supply suitable for the application
•	 Instruments shall be housed in an enclosure with a minimum IP54 rating or location 

providing equivalent protection
•	 Instrument’s final approval shall be provided by the local authority having jurisdiction

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

X – See manual for special conditions
WARNINGS: 

EXPLOSION HAZARD – DO NOT 
DISCONNECT WHILE CIRCUIT IS LIVE 
UNLESS AREA IS KNOWN TO BE NON-
HAZARDOUS.
EXPLOSION HAZARD – SUBSTITUTION 
OF COMPONENTS MAY IMPAIR 
SUITABILITY FOR CLASS I, DIVISION 2.

www.AlicatScientific.com

Alicat Scientific, Inc.
Tucson, AZ USA
Tel: 520-290-6060

II 3 G

USE of Alicat instruments (L, LC, LCR, M, MS, MC, MCS, MCR, MCRS, P, PS, PC, PCS, 
PCR and PCRS product families only) in applications requiring ATEX Certification.
Properly labeled Alicat instruments comply to the following ATEX standard:

II 3 G EEx nA IIC T4 (-40°C ≤ Ta ≤ +50°C)
The examination certificate was issued by the CSA in accordance with 
accepted practices and procedures. This confirms compliance with the 
European ATEX Directive or Group II Category 3G equipment.

ATEX certification is indicated by the product label as shown above and not by the 
statements in this, or any accompanying documentation.
Special Conditions:

•	 Properly labeled equipment is only certified for use in ambient temperatures in the 
range of -40°C to +50°C only

•	 Electrical Rating 24Vdc, 0.800A max
•	 Instruments shall be powered by a CSA certified, UL listed, Class II external power 

supply suitable for the application
•	 Instruments shall be housed in an enclosure with a minimum IP54 rating or location 

providing equivalent protection
•	 Instrument’s final approval shall be provided by the local authority having jurisdiction
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Serial Number: ______________________
Model Number: _________________________
Notice: Alicat Scientific, Inc. reserves the right to make any changes and improvements to the products 
described in this manual at any time and without notice. This manual is copyrighted. This document may 
not, in whole or in part, be copied, reproduced, translated, or converted to any electronic medium or 
machine readable form, for commercial purposes, without prior written consent from the copyright holder.
Note: Although we provide assistance on Alicat Scientific products both personally and through our 
literature, it is the complete responsibility of the user to determine the suitability of any product to their 
application.

Limited Lifetime Warranty
Alicat Scientific, Inc. warrants to the original purchaser (hereinafter referred to as “Buyer”) that 
instruments manufactured by Alicat Scientific (hereinafter referred to as “Product”) shall be free from 
defects in materials and workmanship for the life of the Products.
Under this warranty, the Products will be repaired or replaced at manufacturer’s option, without charge for 
parts or labor when the Product is carried or shipped prepaid to the factory together with proof of purchase.
The foregoing shall constitute the exclusive and sole remedy in lieu of other remedies of the Buyer for 
any breach by Alicat Scientific of this warranty to the maximum extent permitted by law.
This warranty does not apply to any Product which has not been installed or used in accordance with 
the Product operation and installation specifications provided to Buyer verbally or in writing by Alicat 
Scientific for the proper and normal use of the Product.
Buyer agrees hereunder that Alicat reserves the right to void any warranty, written or implied, if upon 
Alicat’s examination of Product shall disclose to Alicat’s satisfaction that the Product failure was due 
solely, or in part, to accident, misuse, neglect, abuse, alteration, improper installation, unauthorized 
repair or improper testing by Buyer or agent of Buyer.
Alicat Scientific shall not be liable under any circumstances for indirect, special, consequential, or 
incidental damages in connection with, or arising out of, the sale, performance, or use of the Products 
covered by this warranty.
Alicat Scientific does not recommend, warrant or assume responsibility for the use of the Products in life 
support applications or systems.
Alicat’s warranties as herein above set forth shall not be enlarged, diminished or affected by, and no 
obligation or liability shall arise or grow out of Alicat’s rendering of technical advice in connection with 
Buyer’s order of the Products furnished hereunder.
If Product becomes obsolete, Alicat Scientific, at its own discretion, reserves the right to repair the 
Product with available replacement parts or upgrade the Product to a current, commercially available 
version of the original Product.  Should upgrading the Product be deemed necessary by Alicat, Buyer 
hereby agrees to pay an upgrade fee equal to seventy percent of the retail value of the replacement 
Product.  Alicat Scientific hereunder makes no claim that replacement Products will look, function or 
operate in the same or similar manner as the original product.
When a Product is returned to Alicat Scientific for recalibration this service is considered normal 
preventative maintenance.  Recalibration of Product shall not be treated as a warranty service unless 
recalibration of Product is required as the result of repairs to Product pursuant to this Warranty.  Failure 
of Buyer to send Product to Alicat Scientific for recalibration on a yearly basis after a period of 36 months 
from date of manufacture will remove any and all obligations regarding repair or replacement of Product 
as outlined by this Warranty to Buyer from Alicat Scientific.
This Warranty is in lieu of all other relevant warranties, expressed or implied, including the implied 
warranty of merchantability and the implied warranty of fitness for a particular purpose, and any warranty 
against infringement of any patent.
Continued use or possession of Products after expiration of the applicable warranty period stated above 
shall be conclusive evidence that the warranty is fulfilled to the full satisfaction of Buyer. 
Alicat makes no warranty as to experimental, non-standard or developmental Products.
Accessories purchased from Alicat are not covered by this warranty.

Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 2006/95/EC and the EMC Directive 
2004/108/EC and carries the CE Marking accordingly. Contact the manufacturer for more information.
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